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chapter 1

Introduction
DigiBase and the DigiBase Pro option (included 
with TDM systems only) combine an intuitive, 
browser-style interface with an integrated da-
tabasing engine, optimized for Pro Tools data 
and media management. 

DigiBase browsers provide extensive databasing 
tools for searching, sorting, auditioning, and 
importing of audio, session, OMF, and other 
types of files. Multiple browsers can be dis-
played and arranged, with custom display set-
tings provided to optimize your work environ-
ment. 
Features

DigiBase (All Systems)

With DigiBase you can:

• View mounted volumes (disks).

• View all content on mounted volumes.

• Search across multiple volumes simulta-
neously.

• Copy, rename, and move files.

• Audition files.

• Drag and drop audio or entire session files 
from browsers into the session.

• View, pause, or resume tasks (such as copying 
files and creating fades) using the Task win-
dow.

DigiBase Pro (TDM Systems Only)

DigiBase Pro provides additional features for 
TDM systems. With DigiBase Pro, you can:

• Create and share custom Catalogs that refer-
ence files wherever they are stored.

• Search on any combination of file metadata.

• View, search, and spot cataloged files even if 
they are on offline volumes.
Chapter 1: Introduction 1
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Conventions Used in This 
Guide
All Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:
:

The following symbols are used to highlight im-
portant information:

Convention Action

File > Save Session Choose Save Session from 
the File menu

Control+N Hold down the Control key 
and press the N key

Control-click Hold down the Control key 
and click the mouse button

Right-click (Windows) Click with the right mouse 
button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
the Pro Tools Guides.
DigiBase Guide
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chapter 2

Overview
DigiBase is a database management tool for 
Pro Tools. DigiBase expands upon basic 
Pro Tools search and import capabilities by pro-
viding powerful tools to manage your data both 
inside and outside of your sessions, regardless of 
where it is stored.

A database is a way of organizing data such that 
it can easily be searched, sorted, managed, and 
utilized. Your checkbook is an example of a da-
tabase file. For every check you write, you enter 
a new record. That record contains information 
about the check, such as when you wrote it, to 
whom you wrote it, and for what amount. This 
information is written in specific columns, or 
fields. Everything you need to know (the check’s 
metadata) is there, even though the check itself 
is not.

DigiBase Elements
Figure 1 shows the various elements of DigiBase. 
Arrows show how files can be moved between 
the elements.
Figure 1.  Data flow

Workspace Browser

Volume Browsers Catalogs

Project Browser

Relink Window Task Window

Pro  Tools 
Session

(TDM Only)
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DigiBase Browsers

DigiBase databases are accessed through Digi-
Base browsers. Browsers provide an intuitive user 
interface to DigiBase databases with many con-
venient features optimized for various file man-
agement tasks (such as search and sort func-
tions).

Browsers in Pro Tools are analogous to windows 
in your computer’s operating system, but are de-
signed and optimized for Pro Tools workflow. 
Multiple browsers can be displayed simulta-
neously, and arranged independently with cus-
tom display settings for each.

Browsers let you search and sort audio files, 
video files, and sessions. Audio and session files 
displayed in browsers can be dragged directly 
into the current Pro Tools session.

When offline items are needed, Pro Tools lets 
you find the correct matching files, then relink 
to online media. 
DigiBase Guide
      

The main elements of a DigiBase browser (see 
Figure 2 on page 5) include the following. 

• The Title bar shows the browser type (Work-
space, Volume, Project or Catalog), and the 
name of its associated volume, session or cat-
alog. 

• The Toolbar provides the Browser menu, 
Search icon, View Presets (numbered 1–5), 
and browser navigation tools. 

• The Items List displays the contents of a vol-
ume, folder, session, or Catalog database. 

• Each column in the items list displays meta-
data (such as file name and format) for vol-
umes, folders, and files in the Items List.

• Columns can be resized by dragging the 
column border, or rearranged by dragging 
the Column headers.

• Columns can be dragged to either of two 
available panes, the Fixed or Scrolling 
panes.
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Figure 2.  Main elements of a DigiBase browser (Volume browser shown).

Toolbar

Items 
List

Fixed pane Scrolling pane

Pane split

Show/Hide

Column headers

TItle bar
There are three types of Pro Tools browsers 
available on all supported systems:

• The Workspace browser

• Volume browsers

• The Project browser

DigiBase Pro provides one additional browser:

• Catalogs

Workspace Browser

The Workspace browser provides access to all 
your mounted volumes, as well as the folders 
and files they contain. 
     

Using the Workspace browser, you can:

• Access all mounted volumes.

• Access all Catalogs.

• Search across multiple volumes and Catalogs 
simultaneously.

• Designate volumes for Record and Playback, 
Playback Only, or Transfer.

• Unmount volumes.

• View, manage, audition and import individ-
ual items in any catalog or mounted volume.

• Update databases for entire volumes.
  
For detailed information about the Work-
space browser, see Chapter 5, “Workspace 
Browser.”
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Volume Browsers

Volume browsers provide file management for 
local and network volumes. Volumes are format-
ted partitions on a physical drive (hard drive). 
Open a Volume browser by double-clicking a 
volume in the Workspace browser. Any changes 
made in Volume browsers (such as copying, de-
leting, or moving files and folders) is mirrored 
on the volumes themselves. Volumes include 
mounted hard drives, network storage, and CD-
ROMs.

Using Volume browsers you can:

• View, manage, audition and import individ-
ual items on the volume.

• Update a database for contents of the volume.

Project Browser

The Project browser provides powerful search 
and management tools for the files referenced in 
your current session, regardless of where they 
are stored. Using the Project browser, you can:

• Show all the media files associated with the 
current session, including any missing files.

• View, manage, audition and spot individual 
items.

Catalogs (TDM Systems Only)

Catalogs provide the highest level of Pro Tools 
file management. Catalogs make it easy to orga-
nize files from multiple sources into libraries of 
favorite files. Catalogs can be sorted and 
searched, even when the files they reference are 
offline. Catalogs can also be shared with other 
Pro Tools TDM users. 

For detailed information about the Project 
browser, see Chapter 6, “Project Browser.”
DigiBase Guide
          

Using Catalogs, you can:

• Collect and organize files from any combina-
tion of volumes.

• Create catalogs of complete volumes to view 
and search even if a volume is offline.

• View, manage, audition, and import individ-
ual items in the catalog.

• Update a database for contents of catalog.

 

Task Window

 

The Task window is a utility for viewing and 
managing all of the background tasks that you 
initiate with Pro Tools. Use the Task window to 
monitor, pause, or cancel background tasks such 
as file copies, searches, indexing, and fade cre-
ation.

 

Relink Window

 

The Relink window provides tools and features 
for relinking sessions and catalogs to media files. 
Use Relink tools to search and reacquire missing 
files for use in the current session. 

  

For detailed information about the Cata-
logs, see Chapter 7, “Catalogs in DigiBase 
Pro (TDM Systems Only).”

For detailed information about the Task 
window, see Chapter 8, “Task Window.”

For detailed information about the Relink 
window, see Chapter 4, “Linking and the 
Relink Window.”
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Performance and Transfer 
Volumes
DigiBase lets you view, manage, and import ses-
sions and media from both Performance and 
Transfer volumes.

Performance Volumes Are storage volumes (hard 
drives) that are suitable for playback and have 
been designated in the Workspace browser as 
Record and Playback (R) or Playback Only (P) of 
media files in a Pro Tools session.

Transfer Volumes Are volumes that are not sup-
ported for media playback in Pro Tools (such as 
shared network volumes or CD-ROMs), or stor-
age volumes (hard drives) that have been desig-
nated in the Workspace browser as Transfer (T) 
volumes. Transfer volumes cannot be used to 
record or play back media in a Pro Tools session. 
Designated Transfer (T) volumes can be useful 
for transferring session and media files between 
different Pro Tools systems.

Digidesign Databases
The information displayed in browsers is stored 
in individual databases. Pro Tools creates these 
databases automatically for all mounted vol-
umes, including Transfer volumes.

Digidesign databases use three file types:

volume.ddb Stores media and session file meta-
data for a particular volume.

For more information on volume designa-
tions, see “Audio and Video Volume Desig-
nators” on page 50.
               

catalog.ddb (TDM Systems Only) 

 

Stores media 
and session file metadata for a user defined Cat-
alog. Cataloged media and session files are can 
reside on multiple volumes, including Transfer 
volumes.

 

cache.wfm 

 

Stores waveform overviews for read-
only audio files.

 

Read/Write Volume Databases (Hard Drives)

 

For each volume, a database file is created in a 
folder named Digidesign Databases, on the root 
level of the volume. The database is stored with 
the volume it describes so that if the volume is 
later moved to a different system the database 
does not have to be recreated.

 

Read-Only Volume Databases (CD-ROMs and 
Write-Protected Volumes)

 

Since data cannot be written to read-only vol-
umes, databases for read-only volumes are 
stored locally on your system drive. On Win-
dows, these databases are stored in the Program 
Files\Digidesign\Pro Tools\Databases\Vol-
umes folder. On Macintosh, they are stored in 
the Library/Application Support/Digidesign/Da-
tabases/Volumes folder. 

 Shared Network Volume Databases 
Though a shared volume may be read/write, 
Pro Tools treats it as if it were a Transfer volume 
and no database is stored on the shared volume. 
Consequently, databases for shared volumes are 
stored locally on your system drive. On Win-
dows, these databases are stored in the Program 

  

If you delete the Digidesign Database 
folder, all existing database information for 
that volume is lost. To recreate a deleted 
Digidesign Database folder, re-index the 
volume (see “Updating and Indexing a Da-
tabase” on page 9).
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Files\Digidesign\Pro Tools\Databases\Vol-
umes folder. On Macintosh, they are stored in 
the Library/Application Support/Digidesign/Da-
tabases/Volumes folder.

Sharing Database Files

Database files can be shared among users. This is 
particularly useful for Transfer volumes, elimi-
nating duplicate processing (indexing) time.

For example, shared volumes (such as network 
storage volumes) tend to be large, and indexing 
can be a time consuming task. To avoid dupli-
cate effort, one user can manually index part or 
all of the shared volume just once, then email 
the database files to other users. Database files 
can be added by placing them within each user’s 
Volumes folder. Periodic manual indexing then 
keeps all databases current.

Sharing Catalogs (TDM Systems Only)

On Pro Tools TDM systems, Catalogs can be cre-
ated for a particular project and then shared 
among multiple systems to help facilitate more 
efficient workflow. DigiBase Pro Catalogs are 
stored as database files on your system drive. On 
Windows, Catalog database files are stored in 
the Program Files\Digidesign\Pro Tools\Data-
bases\Catalogs folder. On Macintosh, they are 
stored in the Library/Application Support/ 
Digidesign/Databases/Catalogs folder. Catalog 
database files can only be shared with other 
Pro Tools TDM systems.
DigiBase Guide
        

Getting Started with DigiBase 
and DigiBase Pro

 

This section provides an overview of DigiBase 
features with steps for first time configuration.

 

Opening DigiBase Browsers

 

As you work with Pro Tools sessions, DigiBase 
provides an intuitive environment for opening 
volumes and folders, auditioning and copying 
files, and importing data into sessions.

To open the Workspace browser:

■ Choose Windows > Show Workspace.

To display contents of a volume or folder:

1  Open the Workspace browser (Windows > 
Show Workspace).

2  Click the Expand/Collapse icon next to the 
item to show its contents in the Workspace 
browser.

– or –

Double-click a volume or folder in the Work-
space browser. 

The contents of the volume or folder are dis-
played in a new Volume browser.

To open the Project browser:

1  Open a Pro Tools session (if one is not already 
open).

2  Choose Windows > Show Project browser.

Press Alt+; (Windows) or Option+; (Macin-
tosh) to open the Workspace browser.

Press Alt+O (Windows) or Option+O (Mac-
intosh) to open the Project browser.
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To open a DigiBase Pro Catalog (TDM only):

1  Open the Workspace browser.

2  If the Catalogs folder is not already expanded, 
click its Expand/Collapse icon.

3  Double-click a Catalog (if present). A new 
DigiBase Pro Catalog browser opens.

To open the Task window:

■ Choose Windows > Show Task window.

Updating and Indexing a Database

The process of indexing is how Pro Tools up-
dates databases. Once indexed, volumes, fold-
ers, and items can be searched much more 
quickly than if they are not indexed. This is vital 
if you are working with large databases, such as 
sound libraries.

Pro Tools automatically indexes the contents of 
each folder when you open its browser. If its 
contents have not been previously indexed, the 
contents begin to appear item-by-item. For large 
databases, the automatic indexing process may 
take a while.

Catalogs in the Workspace browser

Press Alt+’ (Windows) or Option+’ (Macin-
tosh) to open the Project browser.
You can also manually index the entire contents 
of selected volumes or folders by using the Up-
date Database for Selected command in the 
Browser menu. You may want to manually in-
dex volumes or folders prior to starting a project 
to avoid having to wait for automatic indexing 
of a volume or folder during the project. Regular 
periodic indexing of volumes or folders can also 
help speed up your workflow when you are 
working on a project.

To manually index a volume, including all sub-
folders: 

1  Open the Workspace browser (Windows > 
Show Workspace).

2  Select the volume, folder, or item in the Items 
List.

3  From the Browser menu, choose Update Data-
base for Selected. 

Indexing a volume updates the database for the 
entire contents of the volume. Indexing a folder 
updates the database for the items inside that 
folder, as well as items in any sub-folders.

If you're going to run preliminary indexing 
passes on large amounts of data, you may 
want to do it overnight.

Browser menu

Browser
menu
Chapter 2: Overview 9
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Columns and Views

Column width and position can be customized 
in each browser. Additionally, five View Presets 
are provided to store and recall custom display 
configurations.

To customize the data displayed in a DigiBase 
browser, do any of the following: 

■ Drag columns into the Fixed or Scrolling pane 
by dragging their column headers. 

■ Arrange columns within the Fixed and Scroll-
ing pane by dragging their column headers. 

■ Resize columns by dragging the borders be-
tween column headers. 

View Presets

DigiBase lets you save different browser layouts 
as View Presets. View Presets save the current 
column width and position.

View Presets are specific to each type of 
browser—the Workspace, Volumes, the Project 
browser and Catalogs, and the Relink Window. 

To store a View Preset:

1  Open the Workspace browser 

2  Arrange columns and sorting for your first 
view. 

3  Control-click (Windows) or Command-click 
(Macintosh) a View Preset button (1–5). 

4  Repeat in other browsers as needed. 

View Presets

View Presets
DigiBase Guide
To recall each saved preset:

■ Click the appropriate View preset button.

Sorting Items in Browsers

Lists can be sorted by most columns to rearrange 
contents of that browser’s Items List. Secondary 
sorts are available, up to a maximum of four lev-
els. Secondary sorts let you progressively sort 
items by successive columns, such as Tape then 
Timestamp. 

To sort the data displayed in a browser: 

■ Click a column header (such as Kind). The 
number “1” appears in the far right of the col-
umn header, indicating the primary sort.

To add a secondary sort:

■ Alt-click (Windows) or Option-click (Macin-
tosh) the appropriate column. The number “2” 
is displayed in the far right of the column 
header, indicating the secondary sort.

For more detailed information, see “View 
Presets” on page 26. 

Performing a secondary sort
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To toggle the current sort order between 
ascending and descending:

■ Click the Sort toggle arrow, at the top of the 
vertical scroll bars. 

Searching for Items in Browsers

Use DigiBase to find files by name, modification 
date, and kind. 

With DigiBase Pro, you can search multiple cri-
teria simultaneously, and search on any criteria. 
DigiBase Pro also lets you search Catalogs. 

To start a search:

1  Open any browser.

2  Click the Search icon.

Sort toggle arrow

Search icon

You can also start a search by pressing Con-
trol+F (Windows) or Command+F (Macin-
tosh).

Sort toggle

Search icon
3  If in the Workspace browser, select volumes or 
folders to search. 

4  Enter a Name, Date, or Kind to search in the 
appropriate Find field. 

– or –

If using DigiBase Pro (TDM systems only), enter 
search criteria in any column Find field. 

5  Click the Search button, or press Enter. Search-
ing begins, indicated by the spinning arrows in 
the toolbar, and by the Search button changing 
to Stop. The browser fills with items that match 
the search criteria. Items can be selected and au-
ditioned as they are found. 

6  Click the Stop button at any time to stop the 
search, and keep the list of files already found (if 
any). 

Selecting volumes and folders to search

For detailed information on DigiBase 
search functions, see “Searching Items” on 
page 32.

Include in
search
Chapter 2: Overview 11
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Transfer and Missing Files when 
Opening Sessions

DigiBase provides powerful tools to locate and 
acquire needed files when opening a session. 

To open a session if one is not already open:

■ Double-click a session file in a browser. 

As the session opens, Pro Tools locates all media 
files associated with the session. You will be 
prompted if any files are located but reside on 
Transfer volumes (such as CD-ROMs), or if any 
required files cannot be found.

Transfer Files

Media must reside on Performance volumes in 
order to be playable in the session. Performance 
volumes include all currently online volumes 
designated as audio or video R (Record and Play-
back) or P (Playback only) in the Workspace 
browser.

If any files required by the session reside on “T” 
(Transfer) or other volumes unsuitable for play-
back, a warning dialog will appear prompting 
you to copy the files to a suitable volume. If you 
encounter this warning dialog, do one of the 
following:

◆ From the warning dialog, click Yes to copy the 
files to a suitable Performance volume and 
relink to the copies. 

– or –

◆ Click No to leave files where they currently re-
side. The session opens with the relevant files in 
Transfer status. Transfer files will not play in the 
session, but can be copied and relinked at any 
time from the Project browser. (For more infor-
mation, see Chapter 4, “Linking and the Relink 
Window.”)
DigiBase Guide
Missing Files

If any files are missing, the Missing Files dialog 
is displayed. 

If a session contains missing files:

1  Select one of the following options:

• Select Skip All to skip searching for missing 
files (including any missing fade files).

• Select Manually Find and Relink to search 
for missing files before opening the session.

• Select Automatically Find and Relink to let 
Pro Tools search, match, and relink files 
immediately. 

2  Select Regenerate Missing Fade Files if you 
want to exclude fade files from the relink pro-
cess, and regenerate them instead. 

3  Click OK. 

Missing Files dialog when opening a session

See Chapter 4, “Linking and the Relink 
Window” for more information.
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Importing Items using Drag and 
Drop from DigiBase

You can drag and drop audio files and sessions 
from browsers (and Catalogs) into the current 
session. Importing items from a browser works 
much the same as importing files using the Au-
dio Regions List menu commands.

Audio and session files can be dropped into the 
current session, with options determined by 
whether you drop items to the Timeline, or to 
the Audio Regions List.

Importing Audio

To import audio from browsers:

1  Open any browser. 

2  Select one or more files to import. 

3  Do any of the following:

• To place audio in an existing track, select 
an audio file in a browser and drag it onto a 
track at the desired location. Enable Spot 
mode to place dropped items with the Spot 
dialog. 

• To import audio files to the session Audio 
Regions List only, drag selected audio files 
from a browser into the Audio Regions List. 

• To import and add all audio from one ses-
sion into the current session’s Audio Re-
gions List, drag the source session into the 
Audio Regions List. 

You cannot drag files from the Relink win-
dow or the Task window.
• To import all tracks or other session data 
from one session into the current session, 
drag a session file from a browser to the 
Edit window. The Import Session Data dia-
log will open. Select specific tracks and ses-
sion data to import (see “Importing Session 
Data” on page 14).

Imported files may initially appear to be offline 
until copying or conversion is completed (see 
“Timeline and Session Status LEDs” on page 15 
for more information).

With the DigiTranslator 2.0 Integrated Op-
tion, you can drag and drop AAF sequences 
or OMF sequences and files from DigiBase 
browsers. For more information, see the 
DigiTranslator 2.0 Integrated Option 
Guide.

DigiBase does not currently support drag 
and drop of video files.
Chapter 2: Overview 13
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Importing Session Data

To import tracks and other session data:

1  Select a session in a browser.

2  To import data as new tracks, drag a session to 
a blank (non-track) area of the Timeline. 

– or –

Shift-drag a session to the Timeline. 

3  From the Import Session Data dialog, config-
ure import options and click OK.

Import Session Data dialog (TDM version)

For more information about Import Session 
Data, see the Pro Tools Reference Guide.
DigiBase Guide
Converting and Copying Imported Files

When importing audio from DigiBase browsers, 
the following file copying and conversion rules 
apply.

• Imported items located on Transfer volumes 
will be copied to the session Audio Files folder. 

• Imported items that match the session sample 
rate, bit depth, and which reside on Record or 
Playback volumes can be added to the session 
without conversion or copying.

• Items that do not match the current session 
sample rate and bit depth will automatically 
be converted during importing.

Options for Copying Imported Files

You can configure Pro Tools to automatically 
copy imported files that require no conversion, 
or use key commands to manually copy im-
ported media to the session Audio Files folder. 

To enable automatic file copying to the Session 
Audio Files folder during import:

1  In Pro Tools, choose Setups > Preferences.

2  Click the Operation tab.

To suppress automatic sample rate conver-
sion during import, hold the Shift key (Win-
dows or Macintosh) while dragging and 
dropping from a DigiBase browser to the 
Edit window.
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3  Select Automatically Copy Files on Import. 

4  Click Done.

To manually copy an item while importing:

■ Alt-drag (Windows) or Option-drag (Macin-
tosh) items. 

Background Processing and the 
Task Window

Pro Tools handles tasks such as file copying, file 
conversion, relinking, and fade generation in 
the background. These and similar tasks can be 
checked, paused, and resumed in the Task win-
dow (Windows > Show Task window). 

Automatically Copy Files on Import Preference

For more information, see “Copying during 
Import” on page 39. 

Background processes in the Task window
Timeline and Session Status LEDs

Directly above the Audio Regions List are the 
Timeline and Session Status LEDs.

Timeline The Timeline status LED is green when 
all files in use in track playlists are available for 
playback. 

Session The Session status LED is green when all 
audio and fade files referenced by the session are 
available for playback. 

If files are offline, being processed, or otherwise 
unavailable for playback, the Timeline and Ses-
sion status LEDs are red. 

• Offline items are listed in italicized text in the 
Audio Regions List and in the Project browser. 

• A “T” next to an item in a browser indicates 
that it resides on a Transfer volume.

Designating Volumes in the 
Workspace

Volumes (such as hard drives) can be designated 
Record and Playback (R), Playback only (P), or 
Transfer (T).

To designate volumes in the Workspace:

1  Launch Pro Tools.

2  Choose Windows > Show Workspace to dis-
play the Workspace browser if it is not already 
open and in the foreground. 

Timeline and Session Status LEDs 
Chapter 2: Overview 15
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3  In the list of volumes, click and select in the A 
(audio) column to designate volumes as R 
(Record, for recording and playback), P (Play-
back, for playback only), or T (Transfer, for copy-
ing and storage only). Volumes which are 
unsuitable for playback, such as CD-ROMs and 
network drives, are Transfer volumes by default.

4  If you are working with video files, click and 
select in the V (video) column to designate vol-
umes as R (Record, for recording and playback), 
P (Play, for playback only), or T (Transfer, for 
copying and storage only).

Workflow Example
(TDM Only)

This example demonstrates how DigiBase 
browser features, including DigiBase Pro Cata-
logs, can be used in a typical post production 
project. 

For this example, imagine posting audio for an 
animated television commercial for a line of 
products from the Aviary Fish & Chips com-
pany. 

Designating a volume in the Workspace
DigiBase Guide
Launch Pro Tools and Check the Workspace:

1  Launch Pro Tools. The Workspace browser dis-
plays all mounted volumes. It also shows the 
Catalogs icon. 

2  Click the Expand/Collapse icon next to the 
Catalogs icon to show all the Catalogs in the 
Catalogs folder. Since this project does not have 
a Catalog, start by creating one. 

Create a Catalog:

3  From the Browser menu select New Catalog.

4  Name the Catalog Aviary.

5  Click OK. 

A new folder named Aviary appears under the 
Catalog icon in the Workspace browser.

Items in the Workspace browser

Selecting New Catalog from the browser menu

A new Catalog shown in the Workspace browser

Browser menu



DigiBase_1.1.book  Page 17  Monday, June 9, 2003  2:50 PM
Find and Select Audio for the Project:

6  You need to use the sound of footsteps for this 
project and you already have some footsteps re-
corded into the session on a local hard drive. To 
view them, return to the Workspace browser 
and open the Volume browser for this drive.

7  To find all footstep recordings, click the Search 
icon in the Volume browser to show the Search 
tools. 

8  In the File Name Find field, type “foot” and 
press Enter (or click Search). 

Matching files are displayed as they are found. 

9  Select all the files found on that volume and 
drag them onto the Aviary Catalog icon (listed 
in the Workspace browser). 

the Search icon in the Browser toolbar

Search results in the Workspace browser

Search icon
10  Close the Volume browser and double-click 
the Aviary Catalog, the Aviary Catalog browser 
opens, showing the footstep files completely in-
dexed.

11  Next, you need to find some mouse squeaks 
from a new sound effects CD-ROM. Mount the 
CD-ROM and it appears as a new volume in the 
Workspace browser. 

12  To avoid having to index and search through 
every file on the CD-ROM, double-click on the 
CD-ROM’s icon in the Workspace browser to 
open the Volume browser for the CD-ROM. The 
browser shows twenty or more folders (typical 
of sound effects libraries, where sounds are orga-
nized by contents).

13  Click to select (highlight) just the folder 
named Animals, and select Update Database for 
Selected from the Browser menu. This indexes 
only the selected folder, rather than the entire 
disc. 

14  With the folder indexed, perform a search on 
“Mouse.” Several files are found and listed in the 
browser. 

15  Audition each item by clicking the Speaker 
icon next to the waveform. 

16  Select the three best files, and drag them to 
the Aviary Catalog browser. They now appear 
there next to the footsteps we found in the pre-
vious step. 

Items in the Catalog
Chapter 2: Overview 17
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17  Close the browser for the CD-ROM.

Search on Multiple Criteria:

18  Next, you need a car crash that is exactly 5–6 
seconds long. A Catalog already exists for a five-
disc sound effects library, and even though the 
CD-ROMs are not mounted their contents can 
be searched. 

19  Click the Search icon in the Workspace 
browser, select the five Catalogs to be included 
in the search, type “car crash” in the File Name 
Find field, and configure the Absolute Duration 
field to find files that are between 5 and 6 sec-
onds in duration. Despite the fact that the CD-
ROMs are offline (not mounted), matching can-
didates can still be found. 

20  Four files are found that match the search cri-
teria. Drag them onto the Aviary Catalog 
browser to add them to the Catalog (they appear 
as offline items). 

Spot Files from the Catalog:

21  Close all the browsers except the Aviary Cat-
alog. 

22  From the Aviary Catalog browser, drag files 
onto the current session Timeline to spot the 
files to the desired locations:

• The footsteps are immediately available 
and playable because they are already lo-
cated in the Audio Files folder.

Searching for audio files between 5 and 6 seconds
DigiBase Guide
• When mouse squeaks are added, copies of 
the files are automatically made from the 
mounted CD-ROM to the Audio Files folder 
for the session. Copying, and any necessary 
conversion, takes place in the background.

• Spot the desired car crash from the Catalog 
(the crash found on one of the offline CD-
ROMs). Even though the disc is not 
mounted, the car crash file appears in the 
Timeline and the Audio Regions List as an 
offline audio file. When you are ready to 
listen to and work with the (offline) car 
crash effects, mount the CD-ROM with the 
car crashes. Because the CD-ROM is not a 
qualified playback drive, the file still ap-
pears in the Timeline as offline. 

23  In the Project browser, highlight the desired 
file and choose Copy and Relink from the 
Browser menu. Then select an available play-
back volume for the file. Once the copy is com-
pleted, the file appears online in the session, 
indicating it is ready to play. 

Spotting audio from a Catalog into the session

For more information about linking, see 
Chapter 4, “Linking and the Relink Win-
dow.”
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chapter 3

Working with Browsers

Browser Windows and Tools
Figure 3.  Basic browser tools, panes, and columns (Workspace browser shown)

Toolbar
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Title bar
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Columns Search icon
View Presets

Browser menu
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Browsers display all files in their database, in-
cluding Pro Tools and non-Pro Tools files. Un-
known file types can be shown, as well as aliases, 
and desktop folders. 

To maximize processing speed and protect vital 
components, DigiBase does not display all fold-
ers. For example, on Windows DigiBase brows-
ers do not display the Program Files, Windows, 
Digidesign Databases, WU Temp, or System Vol-
ume Information folders; and on Macintosh Di-
giBase browsers do not display the System, Ap-
plications, Library, or Digidesign Databases 
folders. This excludes them from being indexed, 
searched, sorted, or affected in any way by Digi-
Base tasks. You should not store Pro Tools ses-
sion or media files in any of these folders.

The main elements of a DigiBase browser in-
clude the following:

Title Bar Shows the browser type (Workspace, 
Volume, or Project), and the name of its associ-
ated volume or Catalog. 

Toolbar Includes the Browser menu, Search icon, 
View Presets, and browser navigation tools.

Items List Displays the contents of a volume, 
folder, session, or Catalog database. 

Columns Display metadata (such as file name 
and format) for volumes, folders, and files in the 
Items List.

Each row of data in a browser represents an Item 
(such as a file or folder). Data about each item is 
displayed in columns. Columns can be arranged 
and placed in either the Fixed pane or the Scroll-
ing pane. 
DigiBase Guide
Opening Browsers
There are several ways to open, close, and navi-
gate within browsers.

To open the Workspace browser:

■ Choose Windows > Show Workspace. 

To open a Volume browser:

1  Open the Workspace browser (Windows > 
Show Workspace). 

2  Double-click a volume or folder in the Items 
List. A new Volume browser opens.

To open the Project browser: 

1  Open a Pro Tools session.

2  Choose Windows > Show Project Browser.

To open a Catalog browser (TDM only):

1  Open the Workspace browser (Windows > 
Show Workspace). 

2  Click the Expand/Collapse icon next to the 
Catalogs icon to show all Catalogs, if they are 
not already visible. 

3  Double-click a Catalog. 

To open another Volume or Catalog in a new 
browser window and leave the current Volume or 
Catalog browser open:

■ Control-double-click (Windows) or Com-
mand-double-click (Macintosh) the Volume or 
Catalog. 
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Viewing the Contents of a Volume, 
Folder, or Catalog

To expand or collapse the currently selected 
folder:

■ Click the Expand/Collapse icon next to the 
folder.

– or –

Select a volume, folder, or Catalog, and press the 
Right Arrow key to expand, or the left Arrow key 
to collapse.

To move up one browser level: 

■ Click the Back arrow in the Browser toolbar. 

Moving Browsers to the Foreground or 
Background

To bring all open browsers to the foreground:

■ Choose Windows > Browsers > All. 

To send all browsers to the background:

■ Choose Windows > Browsers > Move to Back, 

All open browsers are moved to the background, 
bringing the other windows to the foreground. 
Browsers remain open and accessible. 

To move up one browser level, press Con-
trol+Up Arrow key (Windows), or Com-
mand+Up Arrow key (Macintosh).

Browser navigation icon

To send all browsers to the background, 
press Alt+Shift+J (Windows) or Op-
tion+Shift+J (Macintosh).

Browser Back arrow
To bring an open browser to the foreground:

■ Choose Windows > Browsers, and select an 
open browser from the sub-menu.

To cycle to the next or previous browser:

■ Press Control+Left/Right Arrow keys (Win-
dows) or Command+Left/Right Arrow keys 
(Macintosh).

Closing Browsers

To close all browsers:

■ Alt-click (Windows) or Option-click (Macin-
tosh) the Close box of any browser. 

Working wIth Items in Browsers

Opening Sessions

To open a Pro Tools session listed in a browser:

■ With no Pro Tools session currently open, 
double-click a Pro Tools session file in any Digi-
Base browser. 

Opening AAF and OMF Sequences

(DigiTranslator Only)

On systems with the DigiTranslator 2.0 Option, 
AAF and OMF sequences can be opened from 
DigiBase browsers.

Because the Task window is a utility and 
not a browser, it will remain open.

Pro Tools does not support embedded AAF. 
AAF sequences with embedded media will 
display unknown in the Type column in 
DigiBase browsers.
Chapter 3: Working with Browsers 21
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To open an AAF or OMF sequence from a DigiBase 
browser:

1  With no Pro Tools session currently open, 
double-click the AAF or OMF sequence in a 
browser.

– or –

Drag and drop the AAF or OMF sequence from a 
browser to the Timeline in an open session.

2  Configure the Import Session Data dialog.

3  Click OK.

Creating and Opening Folders

Browsers let you create and manipulate folders 
(file system sub-directories). All folders have Ex-
pand/Collapse icons to show their contents. 
Dragging items onto a folder icon is the same as 
dragging into an open browser. 

To create a new folder in a Volume browser or 
Catalog:

1  Choose Create Folder from the Browser menu. 

2  Enter a name for the folder, and click OK. 
(Click Cancel to cancel the new folder.)

In Volume browsers, the folder is created on 
disk. In Catalogs, the folder is created in the Cat-
alog only. The Items List updates as new items 
are added. 

For more information on importing AAF 
and OMF sequences, refer to the DigiTrans-
lator 2.0 Integrated Option Guide.
DigiBase Guide
To open a folder in the current browser:

■ Double-click the folder, or click the Ex-
pand/Collapse icon for the item. 

To create and open a folder in its own new 
browser:

■ Control-double-click (Windows) or Com-
mand-double-click (Macintosh) the folder. The 
previous (parent) Browser window remains 
open. 

Scrolling and Moving Selections

To scroll the active pane up or down:

■ Press the Page Up or Page Down key.

To scroll to the top or bottom of the active pane:

■ Press Home (for the top) or End (for the bot-
tom).

To move items up or down in the current browser:

1  Select items in a browser, and make sure that 
window is in the foreground. 

2  Press the Up or Down Arrow key.

With the browser in the foreground and the 
folder selected, press Control+Down Arrow 
key (Windows) or Command+Down Arrow 
key (Macintosh) to open a folder in the cur-
rent browser.

With the browser in the foreground and the 
folder selected, press Control+Alt+Down 
Arrow key (Windows) or Command+Op-
tion+Down Arrow key (Macintosh) to open 
a folder in its own new browser.
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Text Entry in Browsers

Many text fields can be edited to replace or up-
date data for an item. 

To enter an edit to a text field and exit, and return 
to the previous display state:

■ Press Enter.

To revert to the previous text and cancel a text 
edit:

■ Press Esc.

Designating Volumes for Record, 
Playback, and Transfer

To manage volumes and data, the Workspace 
browser lets you designate volumes as R (Record 
and Playback), P (Playback only), or T (Transfer). 
Separate columns are provided for audio desig-
nation (“A”) and video (“V”). 

For detailed information on volume designa-
tion, see “Audio and Video Volume Designa-
tors” on page 50. 

Indexing DigiBase Databases
Indexing is the process of reading media files, 
extracting just the metadata for each file, then 
storing that data in an associated database so 
that it may be displayed in the columns of a 
browser. Once a volume or folder has been fully 
indexed, it can be searched very quickly because 
all of the metadata has already been sorted and 
organized.

For details on column editing, see “Column 
Data” on page 27.
If a volume or folder has not been indexed, it 
will be indexed automatically the first time it is 
opened in a DigiBase browser. Volumes or fold-
ers containing a lot of media files can take a long 
time to index. For this reason, you may want to 
manually index specific volumes or files prior to 
starting a project to help expedite workflow.

Indexing while Browsing

The first time you open a Volume browser for a 
volume or folder that has never been indexed, 
Pro Tools automatically begins to fill the data-
base for that level of the volume. You will see 
files and folders start to appear in the browser 
Items List, along with metadata in the columns 
for each item. Indexing continues until you ei-
ther close the browser, or until that folder is 
completely indexed. 

The next time you open that browser, metadata 
for items that have already been indexed is visi-
ble immediately. If the browser or folder was 
closed before indexing was complete, or if the 
contents of the folder have changed since the 
last time it was browsed, Pro Tools will automat-
ically update the database the next time it is 
opened. This way, the database is always up to 
date for the folder you are browsing. (View the 
Task Manager to see current activity.)

Indexing while Browsing saves time because it 
only fills the database for items on the level of 
the volume that you are currently browsing. For 
example, if you are browsing the root level of 
the volume, it will index only the folders and 
files on the root level. If you open a folder, 
Pro Tools will index just the items in that folder. 
As a result, a database is only indexed for the 
parts of the volume that you have browsed. 
However, searches are faster and more complete 
when a volume is already completely indexed. 
Chapter 3: Working with Browsers 23
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Manual Indexing 

Manual indexing fills in all missing data, and 
updates changed data for selected folders and all 
of their sub-folders. 

To update the index for a folder and all sub-folders:

1  Select the item in a browser Items List. 

2  Choose Update Database for Selected from the 
Browser menu. 

To update the index for an entire volume:

1  Select the volume to update in the Workspace 
browser. 

2  Choose Update Database for Selected from the 
Browser menu. 

Last Indexed Date Display

The Last Indexed column shows the date that 
the index for that folder and all of its sub-folders 
was updated. Keep in mind that individual sub-
folders may have been updated more recently.

Automatic Updating for Pro Tools Actions

Whenever Pro Tools adds, deletes, or modifies a 
file on a volume or in a session, the appropriate 
database is immediately updated to reflect the 
change. 

Changes that are made with Windows Ex-
plorer or the Macintosh Finder (such as 
copying or moving files) are not tracked by 
Pro Tools and will only be indexed if the 
necessary folder is browsed or if a manual 
index is performed.
DigiBase Guide
The Browser Menu 
All Browser windows provide a Browser menu in 
the upper left corner of their toolbar. The 
Browser menu provides commands specific to 
each type of browser, as described below. 

Not all browser commands are available in all 
browsers, as noted.

Update Database for Selected Updates the data-
base for the currently selected volumes or fold-
ers.

New Catalog Creates a new, empty Catalog. Re-
quires DigiBase Pro (TDM systems only). 

Create Catalog from Selection Creates a fully in-
dexed catalog of the selected items. Requires 
DigiBase Pro (TDM systems only). 

Calculate Waveform Calculates the waveform 
displays for selected audio files, or all files con-
tained in selected folders. 

New Folder Creates a new folder on the current 
volume, or within the current Catalog. In Vol-
ume browsers, a new folder is created on disk. 

Reveal in Finder Opens the corresponding par-
ent window in the Finder for the currently se-
lected file. 

Reveal in Browser Opens the parent browser for 
the selected item. The selected item is high-
lighted in its parent browser.

Select Offline Files Selects all files that are cur-
rently offline.

Browser menu icon

Browser
menu
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Select Transfer Files Selects all files identified as 
Transfer files (files found on media that do not 
support playback). 

Select Online Files Selects all files that are on-
line. 

Invert Selection Reverses (inverts) the current se-
lection.

Copy and Relink Copies items currently selected 
in the Project browser to a chosen location, and 
relinks the session to the copies instead of the 
originals. Use this to easily move files from a 
Transfer to a Performance volume. This com-
mand is also available in DigiBase Pro Catalogs 
to copy items and relink the current Catalog to 
the copies. 

Relink Offline Opens the Relink window. Avail-
able in the Project browsers only.

Relink Selected Opens the Relink window, with 
all selected files from the current browser dis-
played and selected as Files to Match. Available 
in Catalogs and Project browsers only.

Duplicate Selected Creates a duplicate of the se-
lected items in the same location. 

Lock Selected Locks all selected items. Any files 
already locked will remain so. Locking a folder 
locks all files and sub-folders it contains. 

Unlock Selected Unlocks the selected items. 

Unmount Lets you unmount any online volume. 
Available in the Workspace browser only. 

While Pro Tools is running, always use the 
Unmount command in the Workspace 
browser menu to unmount the volume, or 
quit Pro Tools and then unmount the vol-
ume. 
Delete Selected Deletes any selected item. In 
the Workspace, Project, and Volume browsers, 
deleting an item deletes it from the disk. In Cat-
alogs, you are asked whether you want to clear 
the items from the Catalog (leaving your disks 
unchanged) or delete the files referenced by the 
Catalog items. 

Additional Commands in DigiBase Pro 
Catalogs

In Catalogs, the following additional com-
mands are available to manage Comments in se-
lected items. 

Copy OS 9 Finder Comments to Database Com-
ments (Macintosh Only) Copies an item’s OS 9 
Finder comments to its Database comments.

Copy Database Comments to Clip Names Copies 
an item’s Database comments to its Clip Name. 

Copy File Comments to Clip Names (Macintosh 
Only) Copies an item’s File Comments to its Clip 
Name. 

For more information on Comments, see 
“Comments Fields” on page 28.

OS 9 Finder comments (from the OS 9 Get 
Info window) are not supported in OS X Get 
Info windows. Use the Copy OS 9 Finder 
Comment to Database Comments com-
mand to utilize any OS 9 Finder comments 
stored with your media. 
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Browser Panes and Display
Browsers display an Items List consisting of var-
ious columns (such as file name, size, creation 
date, and sample rate). The Items List is split 
into two panes, one Fixed and one Scrolling. 
The individual columns can be placed in either 
pane, and all columns can be resized, reordered, 
and sorted. 

Fixed and Scrolling Panes

Columns in browser can be placed in either the 
Fixed or Scrolling pane. Move columns you fre-
quently need to see into the Fixed pane. Col-
umns that you use less often can be moved to 
the Scrolling pane. 

To move columns from the Fixed pane to the 
Scrolling pane, or from the Scrolling pane to the 
Fixed pane:

■ Click the column header and drag to the de-
sired pane. 

To show or hide the Scrolling pane:

■ Click the Show/Hide icon in the lower right 
corner of the Fixed pane. 

Arranging and Resizing Columns

To rearrange columns in a pane:

■ Drag the column header to a new position.

To resize a column:

■ Drag the column header boundary to the de-
sired width. 

Show/Hide Scrolling Pane icon

Show/Hide
DigiBase Guide
View Presets

Pro Tools lets you save up to five preset views for 
each type of browser, and the Relink window. 
Presets can be recalled by clicking a View Preset 
button. View Presets are specific to each type of 
browser.

To store a View Preset:

1  Open a browser, or the Relink window. 

2  Arrange columns and views. 

3  Control-click (Windows) or Command-click 
(Macintosh) one of the five View Preset buttons. 

To recall a saved preset:

■ Click the appropriate View Preset button.

About View Preset 1

Preset 1 becomes the default layout for other 
browsers of its type when they are opened for 
the first time. 

Sorting Columns

Columns can be sorted in ascending or descend-
ing order, and multiple sorts can be applied (up 
to four levels).

To sort by columns:

■ Click the column title header. 

It is often helpful to perform a secondary sort 
(for example, to sort by tape and timestamp). 

View preset buttons

Browser View Presets
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To add a secondary sort:

■ Alt-click (Windows) or Option-click (Macin-
tosh) the column title for the secondary sort cri-
teria. 

To toggle the current sort order between 
ascending and descending:

■ Click the Sort toggle arrow, at the top of the 
vertical scroll bars. 

Column Data
In browsers, each row of data represents an item 
in a database (such as a file, session, or volume). 
Each column displays specific data for an item, 
as follows.

Status The Status column is the first column on 
the left, and it displays the status of each item, 
as follows.

File Name Displays the name of the file, folder, 
volume, catalog, or session. This text field is ed-
itable in all browsers except Catalogs. 

A Designates volumes for audio R (Record and 
Playback), P (Playback only), or T (Transfer). 
Available in the Workspace browser only.

Performing a secondary sort

Status Icons and Display

Icon Text Status

none Black Online

none Blue italics Offline

T Blue italics Transfer
V Designates volumes as video R (Record and 
Playback), P (Playback only), or T (Transfer). 
Available in the Workspace browser only. 

Kind Displays whether the volume, folder, cata-
log, or file. For files, this column will display 
what kind of file it is: session file, audio file, 
video file, or other. This field cannot be edited. 

Date Created Displays the creation date of an 
item. This field cannot be edited. 

Date Modified Displays the last modified date for 
the item. This field cannot be edited.

Date Indexed Displays the last indexed date for 
the item. This field cannot be edited.

Size Displays the size of a file in kB. For folders, 
the total size of all files in the folder is displayed. 
This field cannot be edited.

Capacity Displays the total capacity of a volume. 
This field cannot be edited. 

Free Displays the unused space on volumes. 
This field cannot be edited. 

Abs. Duration (Pro Tools 6.1) or Duration 
(Pro Tools 6.0) Displays the duration of a file in 
absolute time (wall clock), regardless of the time 
code format. Absolute Duration is different from 
Avid's Duration display: Avid's Duration display 
is a time code value that equals the end time 
code location minus the start time code loca-
tion. This field cannot be edited.

Number of Channels Displays the number of 
channels in an audio file: mono, stereo, or 3–8 
as appropriate for supported multichannel files. 
This field cannot be edited.

For more information, see “Audio and 
Video Volume Designators” on page 50.
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Sample Rate Displays an audio file’s sample 
rate. This field can be edited in browsers. This 
can be useful when dealing with audio that has 
been pulled up or down, or to force a sample 
rate conversion to occur if that is necessary be-
fore importing a file that otherwise would not 
require conversion.

Bit Depth Displays an audio file’s bit depth. This 
field cannot be edited.

Format Displays the audio file format (such as 
BWF (.WAV) or AIFF). This field cannot be ed-
ited. 

Waveform Displays a graphical overview of an 
audio file. See “Waveforms and Auditioning” on 
page 29 for more information.

File Comment Displays any embedded com-
ments associated with the file. File comments 
are supported with BWF and SD II files, but are 
not supported with AIFF files. File Comments al-
ways remain with the file when copied, con-
verted, or transferred. See “Comments Fields” 
on page 28 for more information.

Database Comment Displays user comments 
stored with the database, with support for 
Finder comments. Available in the Project 
browser and Catalogs only. See “Comments 
Fields” on page 28 for more information.

Path Displays the directory path to the item. 

Link Path Displays the path to the file used for 
relinking. Available in the Relink window only. 

UID Displays the unique ID for a Pro Tools file. 

Clip Name Displays the name of the file, or the 
Avid clip name when the selected item is an 
OMF file. The Clip Name is what appears in the 
Timeline and Audio Regions list when a file is 
imported into a session. This field can be edited 
in Catalogs only, and can be generated using ei-
DigiBase Guide
ther of the Copy Comments to Clip Name com-
mands in the Browser menu (see “Additional 
Commands in DigiBase Pro Catalogs” on 
page 25). 

Tape When DigiTranslator 2.0 is installed, this 
column displays the original Avid tape name if 
the item is an OMF file (audio or video). If an au-
dio file was originally recorded in Pro Tools, this 
field displays the name of the original session. 
Video files originally recorded in Pro Tools with 
AVoption|XL will not display a tape name.

FPS When DigiTranslator 2.0 is installed, this 
field displays the frame rate of the selected item 
if the item is an AAF sequence or an OMF se-
quence or file: 24, 25, 29.97, 30, drop or non-
drop. For sequences, the frame rate at the start 
of the sequence will be displayed.

Original Timestamp Displays the original times-
tamp (time code location) of audio or video 
files. (See the Pro Tools Reference guide for more 
information.)

User Timestamp Displays the user timestamp, if 
any, of audio files only. (For more information, 
see the Pro Tools Reference Guide.) 

Comments Fields

Comments about individual files can be stored 
in the database, and embedded with the file’s 
metadata wrapper. 

There are two types of comments fields: File 
Comments and Database Comments.
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File Comments

File Comments are stored with the metadata of 
the file itself. Not all file types support File Com-
ments. Indexing stores File Comments in the 
database, allowing them to be searched and 
viewed even if the file is offline. File Comments 
can be edited in browsers, as long as the files or 
their parent media are not defined as read-only. 

You can also add and edit File Comments to 
Pro Tools Session files from the Project browser. 
File Comments cannot be edited in Catalogs.

Database Comments

(Catalogs and Project Browsers Only)

Database Comments in a Catalog are stored in 
the Catalog database. Database comments in 
the Project browser are stored in the Session. Da-
tabase Comments, which can be up to 256 char-
acters in length, are searchable, cross-platform, 
and editable. For more information, see “Com-
ments and Catalogs” on page 58. 

Adding and Editing Comments

To add, view, or edit a Comment:

1  Click the Comments field. The field expands 
to display the entire contents of the field if nec-
essary. 

2  Enter or edit a comment. 

3  Press Enter, or click outside the text box to 
close it. 
Waveforms and Auditioning

The Waveform column shows the waveforms 
calculated for items that are audio files. Wave-
form display depends on the following:

• Waveforms are displayed if they have already 
been calculated and stored, either with the file 
metadata or in the global Waveform cache.

• When a file is imported into a session, a wave-
form is automatically calculated for it, if nec-
essary. 

• Waveforms are grey if they have not been 
stored with the file metadata or in the global 
Waveform cache. 

The waveform overview is stored in the file, or 
in the appropriate Digidesign Databases folder. 
For more information, see “Waveform Cache” 
on page 30.

Summed Waveforms for Multichannel Files

Waveform displays for stereo and multichannel 
files are summed. 

Calculating Waveforms for Display

If an audio file item does not have a waveform, 
the waveform must be calculated to be visible in 
a browser Waveform display. 

Waveform displays in a browser

Item waveforms prior to calculation
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To calculate waveforms in a browser:

1  Select online audio files, or folders containing 
audio files, in a browser.

2  Choose Calculate Waveform from the Browser 
menu. 

Auditioning Audio Files

Audio items can be auditioned from within Di-
giBase browsers to preview items before import-
ing, copying, or deleting them. 

Auditioning is routed through Direct I/O, and 
follows the master Audition path as selected in 
the Output pane of the Pro Tools I/O Setup dia-
log. Level is determined by the Master Fader (or 
Auxiliary Input) level in effect on the Audition 
path. 

When auditioned from DigiBase, interleaved au-
dio files with more than two channels are 
summed to mono for auditioning. Multi-mono 
files must be auditioned one file at a time.

To audition from the start of an audio file in a 
browser:

1  Select an audio file in a browser Items List. 
Make sure the browser is the foreground (active) 
window. 

2  Click and hold the Speaker icon (to the left of 
the waveform display). Playback stops when the 
mouse button is released. 

– or –

Press the Spacebar. The Spacebar can start and 
stop playback if the file’s browser is the current 
window. 

Some Pro Tools operations can cause tem-
porary interruptions in DigiBase audition-
ing. 
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To loop audition:

1  Select an audio file in a browser Items List. 
Make sure the browser is the foreground (active) 
window. 

2  Press Alt+Spacebar (Windows) or 
Option+Spacebar (Macintosh).

To stop loop audition:

■ Click in the Waveform. 

– or –

Press the Spacebar. 

To audition from a specific location within the file:

■ Click and hold in the waveform display at the 
desired location. Playback stops when the 
mouse button is released. 

Waveform Cache

A global Waveform cache file stores waveforms 
that cannot be written back to the sound file, 
such as read-only files, files on network and 
other read-only volumes, and interleaved files. 
The global Waveform cache is stored in the 
Digidesign Databases folder on your Pro Tools 
startup volume. For write-enabled volumes, the 
cache is stored with the volume’s Digidesign Da-
tabase files, on that volume. 

Auditioning an audio file
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Selecting Items

To select a single item in a browser:

■ Click the icon for an item. When selected, the 
item Name is highlighted. 

To select multiple items:

■ Marquee-select a group of items, or Shift-click 
additional items. Control-click (Windows) or 
Command-click (Macintosh) to select multiple 
discontiguous items. 

To select all items listed:

■ Press Control-A (Windows) or Command-A 
(Macintosh).

To select all Transfer files in the current window:

■ Choose Select Transfer Files from the Browser 
menu. 

To select all offline files:

■ Choose Select Offline Files from the Browser 
menu.

To select all online files:

■ Choose Select Online Files from the Browser 
menu. 

To reverse the current selection:

■ Choose Invert Selected from the Browser 
menu. 
Moving, Copying, Duplicating, 
and Deleting Items
Moving, copying, duplicating, and deleting 
items in browsers follow the same rules and be-
havior as in the operating system. For example, 
moving a file to another volume copies the file, 
and Pro Tools warns you if an items is about to 
be overwritten or replaced. Dragging an item 
from a Catalog to a Volume browser always 
makes a new copy of the item. 

Moving Items

To move items:

1  Select one or more items and drag them to a 
new location. Moving to a new location on the 
same volume moves the item, while moving to a 
different volume copies the item. 

Copying Items

To copy and move items:

■ Select one or more items and Option-drag 
them to a new location. 

Duplicating Items

To duplicate one or more items:

1  Select one or more items. 

2  Choose Duplicate Selected from the Browser 
menu.

You can drag items directly into the Time-
line or Regions List of the current session. 
See “Importing Audio, Tracks, and Sessions 
with Drag and Drop” on page 37.

To Duplicate selected items in the Browser, 
press Control-D (Windows) or 
Command-D (Macintosh).
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Deleting Items and Folders

You can select and delete files and folders in all 
browsers. If a selected item resides on a read-
only volume, it cannot be deleted. 

If using DigiBase Pro, see “Deleting Catalog 
Items” on page 32 for additional information. 

To delete one or more items:

1  Select one or more items.

2  Press Delete, or choose Delete Selected from 
the Browser menu. 

3  Pro Tools asks you to verify that you want to 
permanently delete selected files from disk. 
Click Delete to proceed, or click Cancel to leave 
your files and disks unchanged. 

To delete locked files:

1  Select one or more items. 

2  Press Control+Delete (Windows) or Com-
mand+Delete (Macintosh).

Deleting Catalog Items

(DigiBase Pro Only)

When you delete a folder or item from a Digi-
Base Pro Catalog, Pro Tools lets you choose 
whether to delete only the alias from the Cata-
log, or also delete the original files from the disk. 

To delete an item from a Catalog. 

1  Open a Catalog and select one or more items. 

2  Press Delete, or choose Delete Selected from 
the Browser menu. 

To skip the warning dialog, hold down the 
Option key while pressing Delete (or while 
choosing Delete Selected). 
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3  When prompted, do one of the following: 

• To remove the aliases for the selected items 
from the Catalog, click Aliases. 

• To delete the selected items from disk (and 
remove their aliases from the Catalog), 
click Files. 

Deleting Folders in Catalogs

Deleting a folder from a Catalog does not delete 
the folder on disk (even if you choose to delete 
all files from disk). Because Catalogs are “snap-
shots” of items, their aliases will only include 
files that resided in the corresponding folder at 
the time the Catalog was created. To avoid po-
tential data loss, folders are never deleted from 
disk, even though you might choose to delete 
Files instead of Aliasas. 

Searching Items
DigiBase provides powerful search capabilities 
so you can quickly search and find files. 

The Workspace browser lets you search across 
multiple volumes and catalogs (if available). All 
other browsers let you search the currently dis-
played contents of that individual browser. 

Performing a search filters the Items List or 
Search Results pane to display only found items 
that match the search criteria. 

DigiBase Pro lets you search on multiple criteria 
in a single search pass, and search Catalogs.

The Relink window provides specialized search 
capabilities for finding and relinking missing 
files. See Chapter 4, “Linking and the Relink 
Window” for more information. 
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Search Features for All Systems

All systems provide the following search capa-
bility:

• Search by item Name, Kind, and Date Modi-
fied.

• Results of a search are displayed in the Items 
List, where they can immediately be selected 
for auditioning, copying, and other opera-
tions. In the Workspace browser, a separate 
“Search Results” pane displays found items. 

• Utilize search syntax modifiers, such as OR, 
wildcard characters, and greater than/less 
than. See “Search Modifiers” on page 34. 

• Search in Quick or Advanced Search mode. 
Quick mode assumes (fills in) wildcard charac-
ters for faster data entry while searching. Ad-
vanced Search mode lets you specify wildcard 
characters for more precise searching. See 
“Search Modes” on page 35 for more informa-
tion.

Additional Search Features for DigiBase Pro

(Pro Tools TDM Only)

With DigiBase Pro you can also: 

• Search by any data column, such as Com-
ments fields, sample rate, format, and so on. 

• Save the results of a search as a new Catalog 
(Catalogs are only available on TDM systems).
Starting a Search

To search the current browser:

1  Click the Search icon to display the Search 
pane. 

2  On all systems, enter text into the File Name 
field to search by name, or enter a date, or select 
a kind from the pop-up menu. See “Entering 
Data for Searches” on page 34 for more informa-
tion.

– or –

If using DigiBase Pro (TDM systems only), 
choose additional search criteria as needed. 
Press Tab to move to the next available search 
field, or Shift+Tab to move to the previous.

3  Click the Search button, or press Enter (Win-
dows) or Return (Macintosh). 

The search begins (indicated by the Search but-
ton becoming a Stop button). Results of the 
search are displayed in the Items List.

To start a search, press Control+F (Win-
dows) or Command+F (Macintosh).

Search icon and Search Pane

Complete, current indexing provides faster, 
better search results. For more information, 
see “Manual Indexing” on page 24).

Search Icon

Search
Pane 
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To stop a search:

■ During a search, click the Stop button. 

This stops the search routine, and the Stop but-
ton changes back to Search. Whatever results 
have already been found continue to be dis-
played, and all entries in search fields are re-
tained. 

To reset your search settings:

■ Click Reset to clear all criteria in search fields, 
and return to the main Browser view (all items). 
The Search pane remains open.

To close the search pane and return to the 
complete Browser view:

■ Click the browser Search icon to toggle the 
Search pane closed or open.

The search is stopped, the Search (and Search 
Results pane) close, and the window returns to 
show the main Browser view. 

Entering Data for Searches

Field Formats and Searching

The following describe the types of data formats 
available (not all search fields are available on all 
systems). 

Text Fields Allow direct entry of text. By default, 
the field is empty. 

Pull-Down Menus Provide options for certain 
fields. For example, the Bit Depth pull-down 
provides choices for Any, 16-bit, or 24-bit.

Date and Time Accepts date and time entries in a 
variety of formats.

Time Code Uses standard Pro Tools time code 
entry shortcuts in hh:min:sec:frames.
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Search Modifiers

Certain fields have small pull-down menus con-
taining modifiers, which limit the search criteria 
entered in the field. 

Modifiers include:

• Equal to (=)

• Less Than (<)

• Greater Than (>)

• Less Than or Equal to (<=)

• Greater Than or Equal To (>=)

• Not Equal to (≠) 

• Range (< >)

About Range-Limited When enabled, a second 
search field is added so that a range of two val-
ues can be entered (such as two dates). Pro Tools 
finds all items that fall between or are equal 
those two values.

Wildcard Characters (* and ?)

An asterisk (*) can be entered at the beginning 
or end of a text entry when you want to perform 
wildcard searches. For example, if you want to 
find all files with a name that ends with scratch, 
you could enter *scratch in the Search field. This 
will find files with names such as vocal.scratch, 
and dialog2.scratch. 

A question mark (?) can be used for single-char-
acter wildcards. For example, a search on f?ee 
will find free, and flee. A similar search on f*ee 
would find frendlee, flippee, flee, free, and so on. 
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OR Searches

The Plus (+) and Minus (–) buttons add and de-
lete OR rows to find results that match the crite-
ria either in the top row or the additional rows.

To add and use OR rows in a search:

1  Click the Plus (+) button to add an OR row 
identical to the upper row, but with no entries 
in the search fields. 

2  To add an additional OR row, click the Plus (+) 
button again. (An empty OR row has no effect 
on the search.)

3  Enter search criteria.

For example, to find all files named either Dog 
or Bark:

• Type Dog in the first File Name field.

• Add an OR row.

• Type Bark in the second File Name field.

4  Click Search. 

To remove OR rows:

■ Click the Minus (–) button to delete the bot-
tom OR row. 

AND Searches

If you enter two or more words in a text field, 
Pro Tools finds files that contain all of those 
words. For example, if you type Dog Bark, only 
files that contain both the words Dog and Bark 
will be found.

Quotations Marks for Text Strings

Text enclosed in quotation marks is searched as 
one text string. For example, if you type “Dog 
Bark” (with quotes), only items with Dog Bark 
anywhere in the File Name will be considered a 
match.
Search Modes

DigiBase provides two different text searching 
environments:

Quick Search Mode Applies wildcards before 
and after each text string. For example, a Quick 
search for Dog will find Dogs, dog_bark, and 
howling_dogs.

Advanced Search Mode Does not automatically 
apply any wildcards. Therefore, an Advanced 
search on Dog will find Big Dog, but not Dogs 
(unless you manually add a wildcard, as de-
scribed in “Wildcard Characters (* and ?)” on 
page 34). 

In addition, Advanced Search recognizes word 
breaks such as underscores and capitalization. 
For example, an Advanced search on Dog will 
also find Big_Dog (Big-underscore-Dog) and Big-
Dog, though it would not find BigDogs.

To enable Advanced Search mode:

■ Click to enable the Advanced Search mode 
option. 

To return to Quick Search mode:

■ Click to deselect the Advanced Search mode.

Search pane

Toggling search mode affects all DigiBase 
browsers. 

Advanced Search 
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About the Searching Process

Searches are conducted in two passes, each indi-
cated by Search Status displayed in the Search 
pane (and the Task window). 

Searching Databases The existing databases are 
searched first. While this is the fastest search 
pass, this search pass can only be as accurate as 
the database (in other words, if the database is 
not completely up to date you might not find 
the files you want). 

File System Search Pass This is the second pass 
of a search. This search is not as fast as the Data-
base pass, but it is more thorough because it is 
not relying on the database, which may or may 
not be current.

Each pass is completed before the next pass 
begins.
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Saving Search Results as a 
Catalog
(DigiBase Pro Only)

To save the results of your search as a Catalog:

1  Choose Edit > Select All, or press Control+A 
(Windows) or Command+A (Macintosh), to se-
lect all items in the Items List.

2  From the Browser menu, choose Create Cata-
log.

For more information, see Chapter 7, “Cat-
alogs in DigiBase Pro (TDM Systems 
Only).”
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Importing Audio, Tracks, and Sessions with Drag and Drop
Figure 4 illustrates some of the options available to import media (audio files and session data) using 
DigiBase. See “Importing Audio” on page 37, and “Importing Sessions and Tracks” on page 38. 
Figure 4.  Importing from browsers by drag and drop 

Drop audio or session files in the 
Regions List to import 

Volumes

Drop audio or session files
in the Timeline to spot, 
or to add as new tracks

Catalogs

Workspace
Importing Audio

Importing does not always convert or copy 
audio files. See “File Conversion on Import” 
on page 39 and “Copying during Import” 
on page 39 for details.

Importing using drag and drop does not nec-
essarily bring the Edit window to the fore-
ground. For example, dragging and drop-
ping a file from a browser into a track leaves 
the source browser in the foreground (not 
the Edit window). Always verify the active, 
foreground window or browser before con-
tinuing.
To import audio into the Audio Regions List:

1  Select items in a browser. 

2  Drag and drop the selected item onto the Au-
dio Regions List. 

To import audio into an existing track:

1  Select an audio file in a browser. 

2  Drag and drop the selected file onto an exist-
ing track at the desired location. The file is im-
ported and placed where it was dropped. 

Video files cannot be imported by drag and 
drop.
Chapter 3: Working with Browsers 37



38

DigiBase_1.1.book  Page 38  Monday, June 9, 2003  2:50 PM
To import audio as new tracks:

1  Select items in a browser. 

2  Shift-drag items and drop anywhere in the 
Edit window. 

– or –

Drop items on to empty space in the Edit win-
dow, below or between tracks. 

To import and spot audio into a track:

1  Enable Spot mode. 

2  Select an audio file in a DigiBase browser. 

3  Drag and drop the items onto a Track playlist 
in the Pro Tools Timeline. The Spot dialog ap-
pears.

4  Enter the appropriate time code location 
(where you want to spot the imported item). 

To import and spot an audio file by its Waveform: 

1  Control-click (Windows) or Command-click 
(Macintosh) in an item Waveform display at the 
approximate reference point you want to use for 
placement in a track. 

2  While continuing to press Control (Win-
dows), or Command (Macintosh), drag and 
drop the waveform onto an existing audio track 
(the source audio file and the destination audio 
track must have the same number of channels).

Auto Spot mode is not supported when im-
porting from DigiBase browsers. Import to 
the Audio Regions List first, then drag from 
there to utilize Auto Spot mode. See the 
Pro Tools Reference Guide for more infor-
mation.
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Snapping to Head and Tail

To import and snap to head:

■ Start-drag (Windows) or Control-drag (Macin-
tosh) and drop an item onto a track. 

To snap to head and copy the item to the session 
Audio files folder:

■ Start-Alt-drag (Windows) or Control-Option-
drag (Macintosh) and drop an item onto a track. 

To snap to tail:

■ Start-Control-drag (Windows) or Control-
Command-drag (Macintosh) and drop an item 
onto a track. 

To snap to tail and copy the item to the session 
Audio Files folder: 

■ Start-Control-Alt-drag (Windows) or Control-
Command-Option-drag (Macintosh) and drop 
an item onto a track. 

Importing Sessions and Tracks

Session files can be dragged and dropped into 
the current session to import (and spot) audio 
files, tracks, and session data. 

• Dragging a session to the Regions List imports 
all the regions from that session (without im-
porting tracks). 

• Dragging a session to a Track playlist in 
Pro Tools LE lets you import tracks. 

• On Pro Tools TDM systems, dragging a session 
to a playlist opens the Import Session Data di-
alog, letting you select tracks and attributes to 
import. The imported session data will begin 
wherever you drop the session in the Time-
line.
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To import tracks and other session data by drag 
and drop:

1  Open a browser. 

2  Drag and drop a Pro Tools session file, or an 
AAF or OMFI sequence (requires DigiTranslator 
2.0), to the current session, as follows: 

• Drag and drop onto an existing track to 
overlay or overwrite data on the target 
tracks. Hold the Shift key while dragging if 
you intend to replace the current track 
playlists with those being imported (the 
Shift key pre-configures the settings in the 
Import Session Data dialog). 

• Drag and drop onto an empty (non-track) 
space in the Edit window Timeline to cre-
ate new tracks for the imported session 
data. 

• Configure the Import Session Data dialog 
as appropriate. (See the Pro Tools Reference 
Guide for details on the Import Session 
Data dialog.) 

File Conversion on Import

By default, files added to the session by drag and 
drop reference the original media, unless they 
do not reside on a valid Performance volume, or 
unless any of the following are true:

• Sample Rate does not match.

• Bit Depth does not match.

• The file is compressed.

• The file is multichannel interleaved.

• The file is WAV format, but the Pro Tools Pref-
erence to Convert all imported.WAV files to 
AES31/BroadcastWave is enabled.

Sample Rate Conversion quality follows the 
Pro Tools Preference setting. 
Assuming that the file resides on a suitable Per-
formance volume, and that the bit-depth 
matches, automatic sample rate conversion can 
be suppressed (for example, to speed importing 
for rough auditioning or when playback speed is 
not critical). 

To suppress automatic conversion during import:

■ Control-Shift-drag (Windows) or Command-
Shift-drag (Macintosh) and drop the item to the 
Timeline from a browser. 

– or –

Import audio using the Audio Regions List 
menu, or the File menu. 

If any items are offline or stored on Transfer vol-
umes, they will need to be relinked to files on 
Performance volumes. (See Chapter 4, “Linking 
and the Relink Window” for more information.)

Copying during Import

If no conversion is necessary, and the files reside 
on a suitable Performance volume, Pro Tools ref-
erences the original version of the media. You 
can also choose to copy media while importing 
by using key commands, or enabling the Auto-
matically Copy Files on Import preference. Cop-
ies are created in the session’s Audio Files Folder. 

To manually copy files on import:

■ Alt-drag (Windows) or Option-drag (Macin-
tosh) and drop the files. A copy is created in the 
session Audio Files folder. 

When importing sessions or tracks, the Import 
Session Data dialog lets you specify whether to 
reference the source media, or copy it.
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To automatically copy files on import:

1  Choose Setups > Preferences, and open the 
Operations tab. 

2  Select Automatically Copy Files on Import. 

3  Click OK to close the Preferences dialog.

Using Undo after Importing 

Using Undo after importing removes any af-
fected files from the Timeline. However, im-
ported items remain in the session (in the Audio 
Regions List and Project browser) and are off-
line. 

If you do not remove or delete the files from the 
session manually, Pro Tools will report them as 
missing files the next time the session is opened. 

Preference to Automatically Copy Files on Import

Click to enable
DigiBase Guide
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chapter 4

Linking and the Relink Window
This chapter explains what links are, how they 
affect a session, and how you can manage and 
restore links between sessions or Catalogs and 
their associated audio files. 

Introduction 
A Pro Tools session is made up of references, or 
links, to audio files and other session media. Au-
dio files must be stored on suitable Performance 
volumes and be properly linked in order to be 
playable in the session.

The following types of files will not be playable:

Transfer Files Files that are stored on volumes 
not suitable for playback, such as network vol-
umes or CD-ROMs.

Missing Files Files that cannot be found where 
the Session expects them, either because they 
have been moved, or because they are stored on 
volumes that are not currently mounted (offline 
volumes).

Links and the Relink window replace the 
functionality of the “Where is...” dialog in 
previous versions of Pro Tools. 
The process of reacquiring Transfer and missing 
files is referred to as relinking. Relinking can in-
volve certain sub-tasks, depending on the situa-
tion.

• Transfer files must first be copied to a suitable 
Performance volume. The session is then 
relinked to the copies on the Performance vol-
umes instead of the original Transfer files.

• Volumes may be searched for missing files 
and, when the files are found, Pro Tools 
relinks the session to the file's new location.

• Files that reside on offline volumes must first 
have their volumes mounted (brought online) 
before they can be relinked.

Choosing When to Relink

Pro Tools lets you relink files while opening a 
session or after a session is already open, as fol-
lows:

◆ Relinking when opening a session ensures 
that the session opens with all media playable. 
Automatic and manual relinking can be per-
formed. See “Opening a Session with Missing 
Files” on page 43. 

DigiBase Pro Catalogs have unique linking 
characteristics. See “Relink and Aliases in 
Catalogs” on page 48. 
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◆ Relinking later (after a session is already open) 
is the fastest way to open the session, but all 
missing items will remain offline and unplay-
able. When items are needed, you can go to the 
Project browser to relink offline items. See 
“Missing Files in an Open Session” on page 44. 

Transfer Files
Unlike missing files, Transfer files are files that 
have been found but which reside on volumes 
unsuitable for playback, such as CD-ROMs or 
network drives. These volumes appear as Trans-
fer volumes in the Workspace browser. 

Opening a Session with Transfer 
Files

If a session finds files on a volume unsuitable for 
playback, a dialog appears prompting you to 
copy them to a suitable volume. Do one of the 
following: 

◆ Click Yes to open the Copy and Relink dialog.

– or –

◆ Click No to open the session with all Transfer 
files offline. When opened, the session’s Project 
browser indicates Transfer files with a “T” in 
their Status column.

Transfer Files in an Open Session

To make Transfer files playable in the current 
session:

1  Choose Windows > Show Project Browser.

2  Double click the Audio Files folder to display 
all of the audio files.

3  Choose Select Transfer Files from the Browser 
menu. 
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4  Choose Copy and Relink from the Browser 
menu. 

5  Specify a location for the copied files on a 
valid Performance volume and click OK. 

6  Repeat for video and fade files, as necessary. 

Copy and Relink 

The Copy and Relink command is a file manage-
ment option in the Project browser and in 
DigiBase Pro Catalogs. 

Copy and Relink provides a convenient way to 
copy files and relink the session or Catalog to 
the copies rather than to the originals. 

To copy items to a new location and Relink to the 
copies:

1  Choose Windows > Show Project Browser. 

– or –

Open the appropriate Catalog. 

2  Select the items you want to copy and relink. 
You can select any media files (online, offline, 
and Transfer files). 

3  Choose Copy and Relink Selected from the 
Browser menu. 

4  If the default location for the copies (the ses-
sion’s Audio Files folder) is not appropriate, 
specify a different location and click Choose. 

5  The files are copied to the chosen destination 
and the session or Catalog is relinked in the 
background. 
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Missing Files
Files will be missing if they are not found in the 
same location as when the session was last 
saved. This could be because you moved the files 
or the session folder, or because the files are on 
a volume that is not currently mounted. 

Opening a Session with Missing 
Files

To open a session with missing files:

1  When you open a session, Pro Tools opens the 
session with all available media, then shows you 
how many files are missing (if any) and asks 
how you want to proceed. (If told that files are 
unsuitable for playback, see “Transfer Files” on 
page 42.)

2  Select one of the following:

• Skip All

• Manually Find Relink

• Automatically Find Relink

3  Select Regenerate Missing Fades to exclude 
fade files from the relink process and regenerate 
them instead.

4  Click OK

Missing files warning when opening a session
Skip All

Use the Skip All option to skip all missing files 
and fades. This option is the fastest way to open 
the session utilizing all available media. Missing 
files will be offline in the session, and shown in 
the Audio Regions List and the Project browser 
with italic text. Missing fades are regenerated if 
the contributing files are online. 

Manually Find and Relink

This option opens the Relink window. Use the 
Relink window to search, compare, verify, and 
relink missing files. Files can be relinked one at a 
time or in batches. See “Relink Window” on 
page 45 for more information. 

Automatically Find and Relink

Automatically Find and Relink is the simplest 
method to relink sessions to required media, but 
it provides no way to compare files or verify 
links. This option cannot be undone. The Auto-
matically Find and Relink option does the fol-
lowing: 

• Searches all Performance volumes for all miss-
ing items with matching Name, ID, Format, 
and Length

• Links missing items to the first matches found

• Commits links for all items possible, in the 
background 

Links, once committed, are final and can-
not be undone once the session is opened. 
The only way to revert to previous links is to 
close the session without saving changes. 
Chapter 4: Linking and the Relink Window 43
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• If some files remain unlinked, the Task win-
dow opens and a failed task appears in the 
Paused Tasks pane. Double-click the Task icon 
to open the Relink window and manually find 
and relink files.

Regenerate Missing Fades

Enable this option to exclude fades from the 
relinking process (fades will instead be recalcu-
lated). This option is available when Automati-
cally Find and Relink or Manually Find and 
Relink is enabled. 

Even if all of the missing files are later 
found and relinked, the failed task remains 
in the Task Window. Like all failed tasks, it 
must be manually selected and deleted. See 
“About Failed Tasks” on page 65. 
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Missing Files in an Open Session

You can open the Project browser to select and 
relink some or all missing files. 

To relink missing (offline) files in an open session:

1  Choose Windows > Show Project Browser.

2  Choose Relink Offline from the Browser menu 
to open the Relink window. 

3  Configure the Relink window as needed. See 
“Relink Window” on page 45 for more informa-
tion. 

To relink selected files in an open session:

1  Choose Windows > Show Project Browser. 

2  Select the files to relink. Any file can be 
relinked, even if it is not an offline file. 

3  Choose Relink Selected from the Browser 
menu. 

4  Configure the Relink window as needed. See 
“Relink Window” on page 45 for more informa-
tion. 
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Relink Window
The Relink window provides tools for all relinking tasks. 
Figure 5.  Main elements in the Relink window

Files to Relink

Candidates

Areas to Search

Menu and toolbar
The Relink window includes the following:

Menu and Toolbar Includes the Relink menu, 
View Presets, and relinking buttons. Status is 
displayed at the far right.

Areas to Search Selects volumes on which to 
search for missing items. 

Files to Relink Lists missing files.

Candidates Lists files that match the “relinking 
criteria” for a particular missing file. The Link 
icon next to the candidate can be toggled on or 
off to link (or unlink) the proposed candidate to 
the selected missing file. 
The Relink window controls each phase of the 
relinking process. 

The following sections explains how to: 

• Open the Relink window 

• Select volumes and folders to search (and not 
search)

• Search, compare, and link individual files to 
one or more candidates 

• Quickly match and link missing files in 
batches, with the ability to adjust the criteria 
by which files are matched.

• Toggle links on or off for any candidate 

• Compare and review links before committing 
Chapter 4: Linking a
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Opening the Relink Window

When opening a session with missing files, use 
the Manually Find and Relink option to open 
the Relink window. 

The Relink window can also be accessed after a 
session is open. 

To access the Relink window from an open 
session:

1  Choose Windows > Show Project Browser. 

2  Choose Relink Offline from the Browser 
menu. 

Selecting Areas to Search

Selecting volumes and folders in the Areas to 
Search pane lets you focus the search for missing 
files. This can speed the relinking process by 
limiting the number of volumes or folders to 
search. In addition, excluding folders from a 
search for missing files also lets you redirect a 
session or Catalog to a more appropriate copy of 
an item.

To select volumes or folders to include or exclude 
in a search:

1  Configure the Areas to Search pane to display 
the appropriate volume, Catalog, or folder. 

2  Click each item’s Search column to toggle it to 
be included or excluded in the search. A check 
next to an item indicates it will be included in 
the search. All folders within items are also 
checked.

Volumes selected to include in the search
DigiBase Guide
Single and Multi-File Relinking

The Relink window can be used to relink one 
missing file at a time, or to relink missing files in 
batches. 

Relinking Individual Missing Files

In some situations, individual files must be 
relinked one at a time in order to relink the ses-
sion to the correct file. This is necessary if mul-
tiple copies of a media file are online, or when-
ever you want the most control and flexibility 
over the relinking process. 

To relink a missing file:

1  Configure the Areas to Search pane. 

2  Select one item in the Files to Relink list. 

3  Click Find All Candidates. 

Relinking a selected missing file

Find All Candidates



DigiBase_1.1.book  Page 47  Monday, June 9, 2003  2:50 PM
Pro Tools searches the selected volumes and dis-
plays all files that match File Name and/or 
Unique ID in the Candidates list. Link icons in-
dicate if a Candidate is already linked.

4  Click the Link icon next to the appropriate 
Candidate to which you want to relink. A Link 
icon next to an item indicates it will be relinked 
to the item currently selected in the Files to 
Relink list.

5  Click the Link icon next to other Candidates, 
if you want to relink to additional missing files.

6  Click the Commit Links button.

Relinking Multiple Missing Files 

Using the Find Links button, multiple files can 
be matched and linked in one procedure. 

To relink multiple missing files:

1  Configure Areas to Search. (See “Selecting Ar-
eas to Search” on page 46.)

OMF video clips can only be relinked to a 
session if they have matching Unique IDs.

QuickTime video clips can only be relinked 
to a session by file name and file format 
(QuickTime).

To control matching and linking criteria 
when relinking an individual missing file, 
use the Find Links button. Find Links is ex-
plained in “Relinking Multiple Missing 
Files” on page 47

Indication of Linked status

Link 
icon
2  Select one or more items in the Files to Relink 
list. The Find Links button becomes available. 

3  Click Find Links. 

4  Configure criteria for relinking, if necessary, in 
the Linking Options dialog.

• By default, Find by Name and ID is en-
abled.

• To add additional matching criteria, select 
an option from the Linking Options dialog. 
(Modification Date is only applicable to 
Catalogs.)

• If Match Duration is enabled, Pro Tools will 
only select files of the same length or 
greater. 

5  Click OK to continue (or click Cancel to re-
turn to the Relink window). 

Pro Tools begins to search for an acceptable can-
didate for the first missing file (the first item se-
lected in the Files to Relink list). A link icon ap-
pears next to each file as Pro Tools finds and 
links the first acceptable candidate to the miss-
ing file. The Link Path column shows the loca-
tion of the selected candidate. Pro Tools contin-
ues searching, matching, and linking for each 
missing file in the Files to Relink list. 

Linking options
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6  To view the selected candidate for a particular 
missing file, select to highlight the missing file. 
That file’s candidate appears in the Candidates 
pane, where you can view its file information 
and waveform.

7  If, after the Find Links process is finished, you 
are not satisfied with the candidate selected for a 
particular missing file, you can click Find All 
Candidates for the selected file (see “Relinking 
Individual Missing Files” on page 46). 

Committing Links

There is no Undo for relinking. Once a file has 
been relinked and the session saved, the session 
will always remember the new link (the original 
link is forgotten). For this reason, no files are ac-
tually relinked until you click Commit Links. 

To commit links:

1  Use the Relink window to link files as ex-
plained in “Single and Multi-File Relinking” on 
page 46. 

2  Click Commit. You are asked to verify com-
mitting links. 

The Automatically Find and Relink option 
is the only relinking process that does not 
ask you to verify links before they are com-
mitted. If you use this option and are unsat-
isfied with the results, close the session 
without saving to prevent the new links 
from being committed. 

Commit Links dialog
DigiBase Guide
3  Click Yes to commit links. 

– or –

Click No to stop without affecting files. 

Tips for Relinking

Relink and Aliases in Catalogs

DigiBase Pro Catalogs are collections of “aliases” 
or “shortcuts” to actual files. If the files are 
moved, an item in a Catalog can become un-
linked from the file it references. 

To relink a Catalog:

1  Open the Catalog. 

2  Select items to relink. 

3  Choose Relink Selected from the Browser 
menu in that Catalog window. 
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chapter 5

Workspace Browser
The Workspace browser is your starting point 
for managing media. The Workspace browser is 
always available while Pro Tools is running, 
even if no session is open.
Only the Workspace browser lets you do the fol-
lowing:

• Designate volumes as Performance volumes 
(Playback or Record volumes) or as Transfer 
volumes. 

• View and access all available volumes

• Unmount volumes

• Create, view, and access Catalogs.

• Search multiple volumes and Catalogs simul-
taneously. 
Figure 6.  Workspace browser, with the Search pane displayed

Browser name

Menu and toolbar

Items List

Search Results

Volume designators

Fixed pane Scrolling pane

Pane split

Show/Hide

Search pane
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The Workspace Browser is similar to your com-
puter’s desktop, in that it shows all of the 
mounted local and network volumes. The 
Workspace browser has all the common browser 
elements, including an Items list, View presets, 
and access to all files. In addition, the Work-
space browser provides drive allocation settings, 
access to catalogs, and the ability to search mul-
tiple volumes and catalogs simultaneously. (For 
a review of common browser features, see 
Chapter 3, “Working with Browsers.”)

Opening the Workspace Browser

To open the Workspace browser: 

1  Launch Pro Tools.

2  Choose Windows > Show Workspace.

Audio and Video Volume 
Designators
The Workspace includes columns for Audio and 
Video Volume Designators. These two columns 
display, and let you designate, whether a vol-
ume is a Record, Playback, or Transfer volume. 

R (Record and Playback) Able to play audio and 
video files already on the volume, and record 
new files. 

P (Playback Only) Can play audio and video files 
already on the volume, but cannot have new 
files recorded to it. 

T (Transfer) Can only be used for storing, trans-
ferring, or auditioning files, and cannot be used 
for recording or playback. 

Press Alt+; (Windows) or Option+; (Macin-
tosh) to open the Workspace browser.
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To change a volume designator:

1  Open the Workspace browser.

2  Click and select the appropriate Audio and/or 
Video designator for the volume. 

Mounting and Unmounting 
Volumes
The Workspace browser lets you unmount vol-
umes while Pro Tools is launched, and shows 
newly mounted volumes as they come online. 

To unmount a volume from within the Workspace 
browser:

1  Select a volume in the Workspace browser. 

2  Choose Unmount Volumes from the Browser 
menu. 

The Workspace browser closes the database file 
for the selected online volume and removes it 
from the Workspace browser, and unmounts 
the disk from the computer. If the item repre-
sents a removable volume (such as CD-ROM), it 
is ejected. 

Pro Tools alerts you if the volume being un-
mounted has files referenced in the Timeline.

Designating a volume in the Workspace

Always use the Unmount command in the 
Workspace browser menu to unmount vol-
umes, or quit Pro Tools and then unmount 
the volume. Do not use any other method to 
unmount a volume while Pro Tools is 
launched. 
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Catalogs in the Workspace 
Browser
(TDM Systems Only)

With DigiBase Pro, the Workspace browser pro-
vides special tools for creating and accessing 
Catalogs. Once Catalogs have been created, they 
appear in the Workspace browser in the Cata-
logs folder. 

To show all Catalogs: 

1  Open the Workspace browser. 

2  Click the Expand/Collapse icon next to the 
Catalogs folder.

To open an individual Catalog:

■ Double-clicking a catalog opens a Browser 
window for that catalog. 

Viewing Catalogs in the Workspace. 

For complete instructions on creating and 
working with Catalogs, see Chapter 7, 
“Catalogs in DigiBase Pro (TDM Systems 
Only).”
Searching in the Workspace 
Browser
The Workspace browser provides the most com-
prehensive DigiBase search capabilities. The 
Workspace browser lets you perform searches 
across a single volumes, multiple volumes, or 
across any combination of volumes, folders, and 
Catalogs. You select which volumes to include 
in the search, and which to exclude. The Work-
space also provides a separate Search Results 
pane to view, select and manage the results of 
searches. 

The Search Results pane lets you maintain the 
results of searches, while still viewing and con-
figuring options for additional searches. 

Search and Search Results panes in the Workspace

Search 
Pane

Areas to 
Search

Search 
Results
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To search from the Workspace:

1  Choose Windows > Show Workspace to open 
the Workspace browser. 

2  Click the Search icon to display the Work-
space Search pane. 

3  Configure search criteria. 

4  Click next to each item in the Areas to Search 
list to include or exclude volumes to be 
searched. Checked items and their sub-folders 
will be included in the search. (The next time 
you open a Search pane in the Workspace, set-
tings will remain in effect.)

5  Click Search. 

6  The results of the search are shown in the 
Search Results pane. 

For more information on searching, see “Search-
ing Items” on page 32. 
DigiBase Guide
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chapter 6

Project Browser
The Project browser displays and manages all 
the files related to the current session, regardless 
of what volume they reside on. 

The Project browser is similar to the Audio Re-
gions List in that is contains all files associated 
with a session, with the added data, searching, 
and sorting capabilities of Pro Tools browsers. 

Unlike the Audio Regions List, however, indi-
vidual regions are not displayed in the Project 
browser (in which only complete files are listed). 
Use the Project browser and its Browser menu 
commands to:

• View all media files associated with a session

• Identify, select, and relink offline files

• Identify, select, copy, and relink Transfer files

The Project browser shows media files associated 
with the current session.
Figure 7.  Project browser

Folders and 
files

Browser menu 
and toolbar
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Opening the Project Browser 

To open the Project browser:

1  Launch Pro Tools and open a session.

2  Choose Windows > Show Project browser.

The Project browser displays the following:

Audio Files Folder Contains all of the audio files 
currently referenced by the session, regardless of 
where they are located. 

Fade Files Folder Contains all of the fade files 
referenced by the session, regardless of where 
they are located. 

Render Sources Folder Contains all files that 
have been imported into the session, but are still 
being converted, copied, or processed. 

Video Files Folder Contains any video files refer-
enced by the session.

Each of the folder types in the Project browser 
have an Expand/Collapse icon. Clicking the 
icon shows or hides all of the files in the sub-
group. The folders displayed in the Project 
browser are session-specific groupings of files, 
not physical folders on disk. 

Press Alt+O (Windows) or Option+O (Mac-
intosh) to open the Workspace browser.
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Display Options

The Show Parent in Project Browser command is 
located in the Audio Regions List menu. This 
setting is latching (meaning it maintains its set-
ting). When enabled, the Project browser auto-
matically highlights the parent file of any file or 
region selected in the Audio Regions List. 

This setting does not change the functionality 
of the Pro Tools preference for Audio Regions 
List Selection Follows Track Selection. When 
both preferences are enabled, selecting a region 
in the timeline highlights it also in the Audio 
Regions List, and highlights its parent file in the 
Project browser.

About the Project Browser

No Drag and Drop to the Project 
Browser

To import a file from another browser into the 
current session, you must drag files to the Time-
line or Regions List. You cannot import a file 
into a session by dragging it to the Project 
browser. (You can, however, spot files from the 
Project browser into the current session using 
drag/drop.)

Deleting Items in the Project Browser

Deleting items in the Workspace browser or in 
Volume browsers deletes the files from disk. 
Video and session files cannot be deleted in the 
Project Browser. 

Deleting an item from the Project browser lets 
you remove items from the current session, or 
delete them from disk (using the Pro Tools Clear 
Regions dialog). 
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Copy and Relink Restrictions

In the Project Browser, the Copy and Relink 
command (in the Browser menu) cannot be 
used on session files, or on offline audio files. 
Use the Relink window to first bring items on-
line. In addition, the Relink Selected command 
cannot be used on session files. 

Updating the Project Browser

The Project browser is automatically updated 
whenever a file is added to or deleted from the 
session, so it is always fully indexed and up to 
date. 

For instructions on searching, sorting, and other 
DigiBase capabilities of the Project Browser, see 
Chapter 3, “Working with Browsers.”
Chapter 6: Project Browser 55
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chapter 7

Catalogs in DigiBase Pro 
(TDM Systems Only)
Catalogs are available with DigiBase Pro on all 
Pro Tools TDM systems. DigiBase Pro is not 
available on Pro Tools LE systems.

While Volume browsers are designed to be an 
accurate representation of the file structure on a 
given volume, Catalogs are similar to having a 
Favorites folder, and serve as a way to collect 
and organize frequently used items regardless of 
where they are stored. 
A Catalog is analogous to a folder full of aliases 
or shortcuts. Placing a file in a Catalog does not 
create a copy of the file, and does not change 
where the file is stored. Rather, it stores a refer-
ence (or alias) to the file so that it can be found 
and manipulated without having to search for 
its physical location. 
Figure 8.  Catalog browser

Catalog Name

Menu and 
toolbar

Items List

Fixed pane Scrolling pane

Pane split

Show/Hide
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Opening a Catalog Browser

Catalogs are displayed in the Workspace 
browser.

To open a Catalog browser:

1  Open the Workspace browser.

2  Click the Catalogs Expand/Collapse icon. 

3  Click the Expand/Collapse icon for the de-
sired Catalog to view its contents in the Work-
space. 

– or –

Double-click the Catalog name to open it in its 
own browser window. 

Clip Names in Catalogs

Clip Names are the names that appear in the 
timeline and Audio Regions List when a file is 
imported into a session. 

For most files, the Clip name is the same as the 
file name. For OMF Files, the Clip Name is the 
name that appears in the Avid bin. 

Clip names can only be edited in a catalog. Ed-
iting the Clip name does not affect the actual 
file, however (if you add the same file to a new 
Catalog, it will retain its original Clip Name). 
When you drag a file from a Catalog into a ses-
sion, the edited Clip Name is what appears in 
the timeline and Audio Regions List. 

If the Clip Name is longer than 32 characters, 
Pro Tools truncates the name automatically 
when imported into the session. 

Catalogs item in the Workspace

Catalogs
DigiBase Guide
Comments and Catalogs

Catalogs provide commands for managing OS 9 
Finder comments, Database comments, and 
Clip Names. 

Database Comments in a Catalog are stored in 
the Catalog database. Database Comments, 
which can be up to 256 characters in length, are 
searchable, cross-platform, and editable. 

Copy OS 9 Finder Comment to Database Com-
ments Copies an item’s OS 9 Finder comments 
to its Database comments.

Copy Database Comments to Clip Names Copies 
an item’s Database comments to their Clip 
Name. 

Copy File Comments to Clip Names Copies an 
item’s File Comments to its Clip Name. 

Creating Catalogs
Catalogs can be added to the Workspace as new, 
empty Catalogs, or you can select items first and 
then save a Catalog of all selected items. 

To create a new, empty Catalog:

1  Open the Workspace browser. 

2  Choose New Catalog from the browser menu. 

3  Enter a unique name and click OK. 

OS 9 Finder comments (from the OS 9 Get 
Info window) are not supported in OS X Get 
Info windows. Use the Copy OS 9 Finder 
Comment to Database Comments com-
mand to utilize any OS 9 Finder comments 
stored with your media. 
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To catalog a selection of items: 

1  Open any browser (including an existing Cat-
alog). 

2  Select the items you want to include in the 
new Catalog. 

3  Choose Create Catalog from Selection from 
the Browser menu. 

A new, fully indexed Catalog database of the se-
lected items is created. 

Creating Catalogs of Folders

To create a Catalog of an entire folder and all its 
contents: 

1  Open the Workspace browser, if not already 
open. 

2  Drag and drop a single folder onto the Catalog 
icon in the Workspace browser. 

Pro Tools first indexes the folder, then a fully in-
dexed Catalog is created, with the same name as 
the dropped folder.

Renaming a Catalog

Catalogs can be renamed at any time. 

To rename a Catalog:

1  Click the Catalog item in the Workspace 
browser until its name highlights. 

2  Enter a new name for the Catalog. 
Modifying, Updating, and 
Relinking Catalogs

Modifying Catalogs

To add items to a Catalog:

■ Open the Catalog and drop new items from 
another browser. 

– or –

■ Click the main Catalogs icon in the Work-
space, to expand your view of all existing Cata-
logs, then drop items onto any Catalog. 

To add a folder to a Catalog:

1  Open the Catalog.

2  Choose Create Folder from the Browser menu. 

To delete items from a Catalog:

1  Select the items. 

2  Press Delete. 

Consolidating Files with Catalogs

Catalogs are excellent tools for consolidating 
files from a variety of sources. 

For example, create a Catalog named “Thumps” 
and fill it with sound effects from three different 
volumes. You can then drag the Catalog from 
the Workspace browser to another volume, and 
a folder named “Thumps” will be created on 
that volume. All of the files referenced by the 
Catalog will be automatically copied to the vol-
ume. Folders and sub-folders, if any, and their 
contents are included in the copy. 
Chapter 7: Catalogs in DigiBase Pro (TDM Systems Only) 59
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Updating Catalogs

Since a Catalog database is not linked to any 
particular volume, there is a limit to the abilities 
of the Update Index command. When Update 
Database for Selected is selected from the 
Browser menu in a Catalog, Pro Tools searches 
for the items represented by the aliases in the 
Catalog and updates the following information:

Metadata Metadata for all files found online, in-
cluding File comments, are updated.

Database Comments Database Comments are 
not updated, because they are unique to each 
Catalog and are not part of the file’s metadata.

Relinking Catalog Items

If files are ever missing from a Catalog, use the 
Relink window to locate, copy, and relink files. 
See Chapter 4, “Linking and the Relink Win-
dow” for more information. 
DigiBase Guide
Deleting Catalogs

To delete a Catalog:

1  Select one or more Catalogs in the Workspace 
browser. 

2  Press the Delete key, or choose Delete Selected 
from the Browser menu. A warning dialog ap-
pears.

3  In the warning dialog, click one of the follow-
ing:

• Click Cancel to cancel the delete operation.

• Click Delete Files to delete aliases and asso-
ciated files from disk.

• Click Delete Aliases to delete only the 
aliases and not the associated files.

This operation cannot be undone. 

Delete Catalog warning dialog
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Importing Catalog Items
You can import online and offline items from 
Catalogs into the current session. 

Importing Online Items from a 
Catalog

Dragging and dropping audio files to the 
Pro Tools Audio Regions List and Timeline is 
identical to dragging and dropping from Vol-
ume browsers. See “Importing Audio, Tracks, 
and Sessions with Drag and Drop” on page 37 
for more information. 

Importing Offline Items from a 
Catalog

With Catalogs, it is possible to search and im-
port files that are offline. For example, if you 
have a music cue that you know you want to 
use, but it resides on a CD-ROM or other un-
mounted volume, you can spot the file from a 
Catalog to the session timeline, and it will be au-
tomatically imported into the session when the 
volume is mounted. 

The first step is to add files to a Catalog (files 
must be online to be added to a Catalog). Once 
added to a Catalog, if the items are taken offline 
they will be listed in italicized text. 

Offline files can be dropped from a Catalog to 
the timeline just like online files. When you 
drop the files, a dialog appears asking if you 
want to relink the files or skip relinking. Click 
Skip All to load all the items as offline files (in 
the timeline, their regions appear in light blue). 
In the Project browser, these items will be listed 
in the Render Sources folder, to ensure that 
Pro Tools remembers that these items need to be 
relinked. 
Whenever the volume containing the offline 
items is mounted, Pro Tools automatically starts 
to import the files, in the background. This is 
true even if you have saved the session, quit, 
and relaunched Pro Tools. 

Once the items are completely imported, they 
appear as online items in the timeline, Audio 
Regions List, and in the Project browser. 

If the offline items match the session sample 
rate, bit depth, and file format, no conversion 
will be necessary. As long as the volume is play-
able, the items will become playable in the ses-
sion as soon as the volume is mounted. 

If the volume is unsuitable for playback, you 
will be informed that some items must be cop-
ied to suitable volumes first. For more informa-
tion on Transfer files, missing files, and relink-
ing, see Chapter 4, “Linking and the Relink 
Window.”
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chapter 8

Task Window
For maximum performance and flexibility with 
file management tasks, Pro Tools provides the 
Task window. File management with Pro Tools 
involves nearly constant creating, copying, con-
verting, searching, and indexing files. These 
tasks occur in the background, letting you con-
tinue recording, editing, and mixing without 
delay. 
The Task window lets you monitor, pause and 
cancel ongoing tasks including file copying, 
fade creation and indexing. 

You cannot drag and drop items to or from 
the Task window.
Figure 9.  Task window, maximum view (upper) and minimized view (lower)

Status

Paused Tasks

Active Tasks

Status

View Toggle 
(Maximize)

View Toggle 
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Opening the Task Window

To open the Task Window:

■ In Pro Tools, choose Windows > Show Task 
Window.

Task Window Messages

If any background task cannot be successfully 
completed, the Task window comes to the fore-
ground to notify you. The incomplete task is 
shown in the Paused Tasks pane of the Task win-
dow. 

Because the Task window is a floating window, 
it does not interrupt current work. This allows 
you to continue recording and editing, and 
postpone file management until a more conve-
nient time.

Window Views

The Task window provides a maximized and 
minimized view. 

To toggle between maximized and minimized 
views:

■ Click View Toggle icon in the top of the Task 
window. 

Task Window Tools, Columns, and 
Displays

The Task window menu provides commands for 
Task window operations.

The following data is always displayed in the 
Task window (both views):

Item Name Indicates affected item, whether a 
file, database, or other supported item.

Press Alt+’ (Windows) or Option+’ (Macin-
tosh) to open the Workspace browser.
DigiBase Guide
Status Action being taken (for example, Copy-
ing, Processing, Indexing and so on).

Progress Indicates the progress of the task or its 
sub-tasks, which include assessing the size of the 
items and the estimated amount of time neces-
sary to complete the task. 

Progress Indicator Indicates processing is ongo-
ing. 

Quantification Shows percentage of progress of 
the current task.

Active Tasks Pane

The upper Active Tasks pane shows the tasks 
that are in progress or waiting to start. The cur-
rently executing task is at the top. Tasks in this 
pane will be processed. 

As tasks complete, they disappear from the 
queue.

Any task that fails to complete successfully is 
moved to the Paused Tasks pane (see below). 
The Status column displays a description of the 
failure.

Paused Tasks Pane

The Paused Tasks pane is displayed below the 
Active Tasks pane, and is separated by a move-
able horizontal divider. Tasks listed in this pane 
will not be processed until they are moved back 
to the Active Tasks pane. 
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Pausing and Cancelling Tasks
The Task window lets you pause, resume, and 
cancel tasks. 

To pause a task:

■ Drag the appropriate task from the Active 
Tasks pane to the Paused Tasks pane. 

The task moves to the top of the Paused Tasks 
pane. 

To pause all tasks:

■ Choose Pause All from the Task window 
menu.

To resume a task:

■ Drag a task from the Paused Tasks pane to the 
Active Tasks pane. The task returns to its previ-
ous position in the queue. 

To resume all paused tasks:

■ Select Resume All from the Task window 
menu. All tasks in the Paused Tasks pane (except 
failed tasks) are moved to the Active Tasks pane. 

To cancel a task:

1  Highlight any task in either pane of the Task 
window.

2  Press Delete to remove it from the Task win-
dow. 

To cancel all tasks:

1  Select any single task in either pane. 

2  Press Control-A (Windows) or Command-A 
(Macintosh) to select all the tasks in that pane.

3  Press Delete.

This command cannot be undone.
About Cancelling Tasks

Some tasks involve one or more sub-tasks. Delet-
ing a task cannot undo sub-tasks already com-
pleted. For example, if importing and convert-
ing multiple files appears a single task, deleting 
that task before it is completed will stop the im-
port and conversion process, but files already 
converted and imported will remain on disk. If 
you want to cancel a task involving multiple 
sub-tasks, you can instead let the process com-
plete and then use Undo to completely undo all 
sub-tasks, as available. 

Closing Sessions with Pending 
Tasks

If you close a session or quit Pro Tools while 
tasks are still pending (either in the Active or 
Paused Tasks panes of the Task window) 
Pro Tools asks if you want to cancel, or complete 
the pending tasks. You can choose to open the 
Task window and wait for pending tasks to com-
plete, cancel the pending tasks, or quit. If you 
quit, some tasks will be cancelled. Tasks that in-
volve file copies will be remembered and re-
started when you relaunch Pro Tools. 

About Failed Tasks

The Paused Tasks pane shows any tasks that 
could not be completed. The reason for the fail-
ure is shown in the Status column. 

Failed Tasks cannot be resumed, and must be de-
leted manually from the Paused Tasks pane. 

If Automatically Find and Relink was unable to 
find all files in a session, a failed task is placed in 
the Paused Tasks pane of the Task window. It re-
mains there unless you manually remove it 
from the Task window (even if you have since 
found the files through a subsequent search and 
relink task). 
Chapter 8: Task Window 65
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Task Prioritization
A task that is in progress may be interrupted by 
a task of higher priority. When this happens, 
the partially completed task is halted and re-
scheduled later in the queue, and shown with a 
progress bar in the Active Tasks pane. When the 
higher priority task is finished the first incom-
plete task in the queue resumes.

Tips for Using the Task 
Window

Pause Tasks During Playback 

A global preference Pause during Playback is 
provided in the Task window Browser menu. 
When enabled, Active Tasks are paused when-
ever Pro Tools is playing (or recording). This set-
ting is especially useful when working on slower 
CPUs, or whenever you want to minimize sys-
tem load for maximum playback and recording 
performance. This Preference maintains its set-
ting until the next time it is changed. 

Stored Tasks

Any task that imports files into a session is 
stored with a session when it is closed, and will 
resume when the session is re-opened. 

For example, if you Import Tracks with Copy 
Media selected, then save and quit before the 
copy completes, the copy tasks will resume 
when the session is reopened. 
DigiBase Guide
Grouped Tasks

Some tasks consist of many smaller tasks. For in-
stance, Copy and Relink may require hundreds 
of individual files to be copied. To help manage 
these tasks, they are grouped under the originat-
ing command. So in the example of a Copy and 
Relink command, one Copy task would appear 
with an Expand/Collapse icon in the Task win-
dow. Clicking the icon shows each of the indi-
vidual sub-tasks.

If there is more than one grouped task in the 
queue, all of the sub-tasks for the first group 
must be completed before the sub-tasks of the 
second group can be processed.

If the session is saved and closed while several of 
these group tasks are in the queue, and if those 
tasks are the type that are saved across close and 
reopen, all of the tasks will appear when the ses-
sion is reopened as part of the same group. 
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appendix a

Keyboard Shortcuts

Browser and Window Keyboard Shortcuts

Table 2. DigiBase Browser and Window Shortcuts
Action Windows Shortcut Macintosh Shortcut

Opens the Workspace browser Alt+Semi-Colon Option+Semi-Colon

Opens the Task Manager window Alt+Comma Option+Comma

Opens or close the Project 
browser

Alt+O Option+O

Brings all browsers to the fore-
ground

Alt+J Option+J

Sends all browsers to the back Alt+Shift+J Option+Shift+J

Zoom Presets in the Edit window

– or –
View Presets in DigiBase brows-
ers

Start 1–5 Control 1–5
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Auditioning Keyboard Shortcuts

Table 3. Auditioning Shortcuts
DigiBase Guide
Delete or Duplicate Keyboard Shortcuts

Action Windows Shortcut Macintosh Shortcut

Browser Item: Starts or stops 
auditioning from head

– or –
Audio Import Dialog:
Starts or stops auditioning from 
head

Spacebar Spacebar

Browser Item: Starts or stops 
loop auditioning from head

Alt+Spacebar Option+Spacebar

Import Audio Dialog: Starts or 
stops auditioning

Alt+P Command+P
Table 4. Delete or Duplicate Shortcuts
Action Windows Shortcut Macintosh Shortcut

Region List: Deletes a Region 
from the timeline

– or –
Browser Item: Deletes items from 
the browser/disk

Delete Delete

Deletes locked files selected in a 
browser

Control+Delete Command+Delete

Deletes any selected browser 
item, and suppresses any warn-
ing dialog

Alt+Delete Option+Delete

Creates duplicates of any 
selected files

Control+D Command+D
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Mouse Click Keyboard Shortcuts

Table 5. DigiBase Mouse Click Modifiers
Action Windows Shortcut Macintosh Shortcut

Selects contiguous items in a 
browser

– or –
Selects a range of contiguous col-
umn headers

– or –
Selects dis-contiguous items only 
in the Regions List (must use 
marquee for contiguous selec-
tion)

Shift-Click Shift-Click

Selects all of the files in a multi-
channel file in a browser

Alt-Shift-Click Option-Shift-Click

Column Headers: Makes a sec-
ondary sort order

– or –
Region List: Auditions a file

– or –
Browser Find Button: Cancels a 
search, and closes the Search 
pane

– or –
Browser Close Box: Closes all 
open browsers

Alt-Click Option-Click

Column Header: Hides a column 
for the individual browser

Control-Alt-Click Command-Option-Click
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Browser Back Button: Opens the 
navigation menu

– or –
Browser Items: Selects dis-con-
tiguous items

– or –
Column Headers: Selects dis-
continuous column headers

– or –
Browser Up Button: Opens menu 
for navigating up several levels.

– or –
Browser View Preset Buttons: 
Stores column order and width, 
and sort order

– or –
Region List: Select a region with-
out changing which region is high-
lighted in timeline

Control-Click Command-Click 

Browser Items: Opens a new win-
dow and leaves the original win-
dow open

Control-Double-Click Command-Double-Click

Table 5. DigiBase Mouse Click Modifiers

Action Windows Shortcut Macintosh Shortcut
DigiBase Guide
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Drag and Drop Keyboard Shortcuts

Table 6. DigiBase Drag and Drop Modifiers
Action Windows Shortcut Macintosh Shortcut

Browser Item: From one folder to 
another folder on the same vol-
ume will create a copy of that 
item in the target location

– or –
Browser Media File to Region List 
or Timeline: Creates a copy of the 
media file in the session’s Audio 
Files folder

Alt-Drag and Drop Option-Drag and Drop

Browser File: Imports to timeline 
and creates a new track.

Shift-Drag and Drop Shift-Drag and Drop

Waveform Display: Sets sync 
point and spots to timeline

– or –
Region List: Opens the Replace 
Region dialog

Control-Drag and Drop Command-Drag and Drop

Waveform Display: Sets the sync 
point and spots to the timeline 
and copies the audio file

Control-Alt-Drag and Drop Command-Option-Drag and Drop

Browser item to timeline: Sup-
presses automatic sample rate 
conversion

Control-Shift-Drag and Drop Command-Shift-Drag and Drop

Region List: Snaps to head

– or –
Browser Audio File, from Name or 
Icon: Snaps to head

– or –
Browser Audio File, from Wave-
form Display: Spots to temporary 
sync point

Start-Drag and Drop Control-Drag and Drop

Browser Audio File to Timeline: 
Snaps to head and copies the 
audio file to the session’s Audio 
Files Folder

Start-Alt-Drag and Drop Control-Option-Drag and Drop
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Spotting without Dragging Keyboard Shortcuts

Region List: Snaps to sync point

– or –
Browser Item: Snaps to sync 
point

Start-Shift-Drag and Drop Control-Shift-Drag and Drop

Browser Item: Snaps to sync 
point and copies the audio file to 
the session’s Audio Files Folder

Start-Alt-Shift-Drag and Drop Control-Option-Shift-Drag and 
Drop

Region List: Snaps to tail

– or –
Browser Item: Snaps to tail

Start-Control-Drag and Drop Control-Command-Drag and Drop

Browser Item: Snaps to tail and 
copies the audio file to the ses-
sion’s Audio Files Folder

Start-Control-Alt Drag and Drop Control-Command-Option-Drag 
and Drop

Browser Item: Spots with variable 
cursor

Start-Control-Shift Drag and Drop Control-Command-Shift-Drag and 
Drop

Browser Item: Spots with variable 
cursor and copies the audio file 
to the session’s Audio Files 
Folder

Start-Control-Alt-Shift-Drag and 
Drop

Control-Command-Option-Shift-
Drag and Drop

Table 6. DigiBase Drag and Drop Modifiers

Action Windows Shortcut Macintosh Shortcut
Table 7. Spotting without Dragging Shortcuts
DigiBase Guide
Action Windows Shortcut Macintosh Shortcut

Browser Item: Spots to head with-
out dragging

Start+Alt+H Control+Option+H

Browser Item: Spots to tail with-
out dragging

Start+Alt+T Control+Option+T

Browser Item: Spots to sync point 
without dragging

Start+Alt+S Control+Option+S

Browser Item: Spots to User 
Timestamp without dragging

Start+Alt+U Control+Option+U
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Navigation Shortcuts

Table 8. DigiBase Navigation Shortcuts
Action Windows Shortcut Macintosh Shortcut

Selection Up Up Arrow Up Arrow

Selection Down Down Arrow Down Arrow

Scroll Page Up Page Up Page Up

Scroll Page Down Page Down Page Down

Scroll to Top of Browser Home Home

Scroll to Bottom of Browser End End

Up one browser level (same as up 
arrow icon)

Control+Up Arrow Command+Up Arrow

Open Folder (same window) Control+Down Arrow Command+Down Arrow

Open Folder (new window) Control+Option+Down Arrow Command+Option+Down Arrow

Open Show/Hide Icon Right Arrow Right Arrow

Close Show/Hide Icon Left Arrow Left Arrow

Cycle to next or previous Browser Control+Left/Right Arrows Command+Left/Right Arrows

Enter/Exit Name Edit field Enter Enter/Return

Revert to original text Esc Esc

Open/Close Search Pane Control+F Command+F

Move to Next Search Field Tab Tab

Move to Previous Search Field Shift+Tab Shift+Tab
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Symbols
+ and – (see Plus (+) and Minus (–))

A
Abs. Duration 27
Active Tasks 64
Audio Designator 50
auditioning

in browsers 30
looping 30

Automatically Copy Files on Import 40
Automatically Find and Relink 43

B
Bit Depth 28
browsers

display options 26
foreground 21
general information 4, 20
menu 24
navigating 20
opening 20
sorting 26
windows 19

C
Calculate Waveform 24
candidates 45
Capacity 27
Catalogs

Clip Name 58
consolidating with 59
creating 58
creating folders in 22
deleting folders 32
opening 58
searching 59
window 57
Clip Name 28, 58
Comments 28

Database 29
File 29

consolidating media 59
Copy and Relink 25
copying items 31
Create Catalog from Selection 24
criteria

linking 47

D
database

files and sharing 8
Database Comment 28
Date Created 27
Date Indexed 27
Date Modified 27
Delete Selected 25
deleting items 31

folders in Catalogs 32
designating volumes 50
DigiBase and DigiBase Pro

preferences 66
display in browsers 26
drag drop

importing via 37
Duplicate Selected 25
Duration 27

E
example workflow 16
index
Index 75
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F
fades

regenerating 44
Failed Tasks 65
File Comment 28
File Name 27

see also Clip Name
files

Clip Name 58
Kind 27
missing 43
missing fades 43
Transfer 42

Find All Candidates 46
Find Links 47
Finder Comments (see Database Comments)
folders

creating and opening 22
deleting from Catalogs 32

foreground 21
Format 28
FPS 28
Free 27

G
guide conventions 2

I
importing

and file conversion 39
audio using drag and drop 37
copying during 40
offline items from Catalogs 61
reference or copy 39

index date 27
indexing 23
Invert Selection 25
Items

copying, moving, deleting 31
selecting 31

K
Keyboard Shortcuts 67
Kind 27
DigiBase Guide
L
Linking Options 47
links 41
Lock Selected 25

M
Manually Find and Relink 43
Minus (–) button 35
missing files

candidates 45
fades and regenerating 43
finding 43
skipping 43

modifiers (browser search) 34
modify date 27
moving items 31

N
Name (file name) 27
navigating 20
New Catalog 24
New Folder 24
Number of Channels 27

O
offline

files, relinking 25
files, selecting 24

OR
search modifier 35

Original Timestamp 28

P
P (browsers) 50
Path 28
Paused Tasks 64
pending tasks 65
Performance Volume

defined 7
Playback 7
Record 7

Plus (+) and Minus (–) buttons 35
Preferences

Automatically Copy Files on Import 40
Pause during Playback 66
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Project browser 53, 55

Q
Quick Search 32

R
R (browsers) 50
reference or copy when importing 39
Regenerate Missing Fades 44
Relink Offline 25
Relink Selected 25
Relink window 45
relinking

basics 41
candidates 45
Copy and Relink 42
Find Links 47
Linking Options 47

Render Sources 54, 61
Reveal in Browser 24
Reveal in Finder 24

S
Sample Rate 28
Search Criteria

OR 35
searching 32

modes 35
modifiers 34
Wildcard Characters 34

Select Offline Files 24
Select Online Files 25
Select Transfer Files 25
Show Parent in Project browser 54
Size 27
Skip All 43
sorting

data in browsers 26
secondary sorts 27

suitable volumes (see Transfer files)

T
T (browsers) 50
Tape 28
Task window 63
using 63

tasks
active 64
failed 65
grouped 66
pausing during playback 66
pending 65
suspended 64

tips
managing tasks 66
relinking 48
sharing database files 8

Transfer
files 42
selecting files 25

Transfer volume
defined 7

U
UID 28
Unlock Selected 25
Unmount 25
Update Database for Selected 24
User Timestamp 28

V
Video Designator 50
volume

Performance 7
Transfer 7

volumes
suitable
Volume browsers 4, 20

W
Waveform 28

Cache 30
Waveform (in browsers) 29
Where is (see relinking)
workflow example 16
Workspace 49

opening 49
searching 51
window 49
Index 77
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